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SUMMARY:  34 
Here we present simplified methods for fabricating transparent neurovascular phantoms and 35 
characterizing the flow therein. We highlight several important parameters and demonstrate 36 
their relationship to field accuracy. 37 
 38 
ABSTRACT:  39 
Particle image velocimetry (PIV) is used in a wide variety of fields, due to the opportunity it 40 
provides for precisely visualizing and quantifying flows across a large spatiotemporal range. 41 
However, its implementation typically requires the use of expensive and specialized 42 
instrumentation, which limits its broader utility. Moreover, within the field of bioengineering, in 43 
vitro flow visualization studies are also often further limited by the high cost of commercially 44 
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sourced tissue phantoms that recapitulate desired anatomical structures, particularly for those 45 
that span the mesoscale regime (i.e., submillimeter to millimeter length scales). Herein, we 46 
present a simplified experimental protocol developed to address these limitations, the key 47 
elements of which include 1) a relatively low-cost method for fabricating mesoscale tissue 48 
phantoms using 3-D printing and silicone casting, and 2) an open-source image analysis and 49 
processing framework that reduces the demand upon the instrumentation for measuring 50 
mesoscale flows (i.e., velocities up to tens of millimeters/second). Collectively, this lowers the 51 
barrier to entry for nonexperts, by leveraging resources already at the disposal of many 52 
bioengineering researchers. We demonstrate the applicability of this protocol within the context 53 
of neurovascular flow characterization; however, it is expected to be relevant to a broader range 54 
of mesoscale applications in bioengineering and beyond. 55 
 56 
INTRODUCTION:  57 
PIV is widely used in experimental fluid mechanics for flow visualization and quantitative 58 
investigations of fluid motion that vary in length scale from atmospheric to microcirculatory 59 
flows1-3. While the specifics of its implementation can vary as widely as its applications, one 60 
aspect common to nearly all PIV studies is the use of video imaging of tracer particles seeded 61 
within the working fluid, followed by a pair-wise analysis of consecutive image frames to extract 62 
desired flow characteristics. Typically, this is accomplished by first subdividing each image frame 63 
into smaller regions termed interrogation windows. As a consequence of the random positions 64 
of the dispersed particles, each interrogation window contains a unique distribution of pixel 65 
intensities. If the window size and data acquisition rate are chosen appropriately, cross-66 
correlation of the intensity signal in each window can be used to estimate the average 67 
displacement within that region. Finally, given that the magnification and frame rate are known 68 
experimental parameters, an instantaneous velocity vector field can be readily computed.  69 
 70 
A major advantage of PIV over single-point measurement techniques is its ability to map vector 71 
fields across a two- or three-dimensional domain. Hemodynamic applications, in particular, have 72 
benefited from this capability, since it allows a thorough investigation of local flows, which are 73 
known to play a significant role in vascular disease or remodeling (e.g., atherosclerosis, 74 
angiogenesis)4-6. This has also been true for the evaluation of neurovascular flows, and the 75 
interactions thereof with endovascular devices (e.g., flow diverters, stents, intrasaccular coils), 76 
since the relevant length-scales in such applications can often span one or more orders of 77 
magnitude (e.g., from micrometer to millimeter), and device geometry and placement can 78 
significantly impact the local fluid mechanics7.  79 
 80 
Most groups conducting PIV-based hemodynamic studies have relied on experimental set-ups 81 
that closely mimic some of the earliest investigations of stent influence on vascular flow7,8. 82 
Typically, these include a) pulsed lasers and high-speed cameras, to capture high-velocity flows; 83 
b) synchronizers, to prevent aliasing between the pulse frequency of the laser and the camera 84 
acquisition frame rate; c) cylindrical optics, to form a light sheet and, thus, minimize the 85 
background fluorescence from tracer particles above and below the interrogation plane; d) in the 86 
case of commercial turn-key systems, proprietary software packages, to perform the cross-87 
correlation analyses. However, while some applications require the performance and/or 88 



   

 

versatility collectively afforded by these components, many others do not. Moreover, the high 89 
cost of commercially sourced tissue phantoms that recapitulate desired vascular structures can 90 
also prove limiting for many in vitro studies, particularly for phantoms with features that bridge 91 
the mesoscale regime (> 500 USD/phantom). Herein, we report the development of a simplified 92 
protocol for implementing PIV for the in vitro visualization of neurovascular flows, which typically 93 
lie both spatially and temporally within the mesoscale regime (i.e., length scales ranging from 94 
submillimeter to millimeter, and velocities up to tens of millimeters/second). The protocol seeks 95 
to leverage resources already at the disposal of many bioengineering researchers, thus lowering 96 
the barrier to entry for nonexperts. 97 
 98 
The first element of this protocol involves the use of an investment casting technique to enable 99 
the in-house fabrication of transparent, polydimethylsiloxane (PDMS)-based tissue phantoms 100 
from 3-D-printed sacrificial molds. By leveraging the increasing availability of 3-D printers in 101 
recent years, particularly those in shared/multi-user facilities (e.g., institutional facilities or public 102 
makerspaces), this methodology cuts costs significantly (e.g., < 100 USD/phantom in the case 103 
presented here), while enabling a rapid turnaround for the fabrication of a wide variety of designs 104 
and geometries. In the current protocol, a fused deposition modeling system is used with 105 
acrylonitrile butadiene styrene (ABS) as the building material, and the printed part serves as a 106 
sacrificial mold for the subsequent phantom casting. Our experience has shown that ABS is well-107 
suited for such use since it is soluble in common solvents (e.g., acetone), and it has sufficient 108 
strength and rigidity to maintain mold integrity after the removal of the support material (e.g., 109 
to prevent the deformation or fracture of diminutive mold features). In the current protocol, 110 
mold integrity is further ensured using solid printed models, although this comes at the expense 111 
of increased dissolution time. The use of hollow models may also be possible in some cases, to 112 
enhance solvent access, and thus, reduce dissolution time. However, careful consideration 113 
should be given to the effect this may have on mold integrity. Finally, while the phantoms 114 
fabricated herein are based upon idealized representations of neurovascular structures 115 
generated using a common computer-aided design (CAD) software package, the protocol is 116 
expected to be amenable to the fabrication of more complex, patient-specific geometries as well 117 
(e.g., via the use of model files generated by the conversion of clinical imaging data to the .STL 118 
file format used by most 3-D printers). Further details regarding the phantom fabrication process 119 
are provided in section 2 of the protocol. 120 
 121 
The second element of the protocol involves the use of an open-source plug-in for ImageJ to 122 
conduct the cross-correlation analyses9. This is coupled with the implementation of a simple 123 
statistical thresholding scheme (i.e., intensity capping)10 to improve the image signal prior to 124 
cross-correlation, as well as a postcorrelation vector validation scheme, the normalized median 125 
test (NMT), to eliminate spurious vectors through a comparison of each to its nearest 126 
neighbors11. Collectively, this allows imaging to be accomplished using equipment commonly 127 
found in many bioengineering laboratories, thus eliminating the need for the acquisition of many 128 
of the costly components of typical PIV systems (e.g., pulsed laser, synchronizer, cylindrical 129 
optics, and proprietary software). Further details regarding the video collection, image 130 
processing, and data analysis are provided in sections 5 and 6 of the protocol. 131 
 132 



   

 

Figure 1 illustrates the PIV set-up used in this protocol, which relies upon a fluorescence 133 
microscope equipped with a high-speed camera for imaging, as well as an external, continuous 134 
white-light source (i.e., metal halide lamp) for through-objective volumetric illumination. A 135 
variable-speed gear pump is used to impose the recirculating flow of a transparent mock blood 136 
solution through the neurovascular tissue phantoms. The solution is composed of a 60:40 137 
mixture of deionized (DI) water and glycerol, which is a common substitute for blood in 138 
hemodynamic studies12-14, due to a) its similar density and viscosity (i.e., 1080 kg/m3 and 3.5 cP 139 
vs. 1050 kg/m3 and 3 - 5 cP for blood)15,16; b) its transparency in the visible range; c) its similar 140 
refractive index as PDMS (1.38 vs. 1.42 for PDMS)17-20, which minimizes optical distortion; d) the 141 
ease with which non-Newtonian behavior can be introduced, if needed, via the addition of 142 
xanthane21. Finally, fluorescent polystyrene beads are used as tracer particles (10.3 μm in 143 
diameter; 480 nm/501 nm excitation/emission). While neutrally buoyant beads are desired, 144 
sourcing tracer particles with optimal fluid mechanical properties (e.g., density, size, 145 
composition) and emission wavelength can prove challenging. For example, the beads used 146 
herein are slightly less dense than the glycerol solution (1050 kg/m3 vs. 1080 kg/m3). However, 147 
the hydrodynamic effects, thereof, are negligible, given that the duration of a typical experiment 148 
is far shorter than the time scale associated with buoyancy effects (i.e., 5 min and 20 min, 149 
respectively). Further details regarding the mock blood solution formulation and in vitro 150 
circulatory system set-up are provided in sections 3 and 4 of the protocol.  151 
 152 
PROTOCOL:  153 
 154 
1. ABS-based Sacrificial Mold Fabrication 155 
 156 
1.1. Design an inverse model of the desired tissue phantom using CAD software. 157 
 158 
1.2. Print the model using a 3-D printer with ABS as the building material. 159 
 160 
2. PDMS-based Vascular Phantom Fabrication 161 
 162 
2.1. Mixing 163 
 164 
2.1.1. Mix the PDMS prepolymer base and curing agent in a 10:1 ratio (by weight); a 66 g mixture 165 
provides sufficient material for the fabrication of phantoms with volumes up to 50 cm3. 166 
 167 
2.1.2. Place the mixture in a vacuum desiccator for 60 min to degas and minimize the bubble 168 
entrapment. Use cyclic pressurization/depressurization to facilitate bubble rupture.  169 
 170 
2.2. Casting  171 
 172 
2.2.1. Mount the printed ABS mold on a glass slide using molding putty to seal the interface. 173 
 174 
2.2.2. Carefully pour the PDMS mixture into the mold while trying to minimize bubble 175 
entrapment. Lingering bubbles can be manually ruptured using a needle. 176 



   

 

 177 
2.2.3. Cure the cast phantom at room temperature (25 °C) for at least 24 h. 178 
  179 
NOTE: At higher temperatures, this process can be accelerated22.  180 
 181 
2.3. Demolding 182 
 183 
2.3.1. Dissolve the ABS by submerging the phantom in acetone and sonicating for at least 15 min, 184 
using powers up to 70 W.  185 
 186 
CAUTION: Acetone has a high vapor pressure at room temperature and a low flash point. 187 
Consequently, always work under a fume hood and away from potential ignition sources. Wear 188 
proper personal protective equipment (e.g., goggles or face shield, lab coat, acetone-resistant 189 
gloves). 190 
 191 
2.3.2. Thoroughly rinse the phantom with isopropyl alcohol and, then, DI water to remove 192 
solvent residues. 193 
 194 
NOTE: PDMS swells upon exposure to acetone; however, the swelling subsides once the phantom 195 
is rinsed and dried sufficiently23. 196 
 197 
2.4. Confirmation of phantom fidelity using optical microscopy 198 
 199 
2.4.1. Using an optical microscope with an attached camera and image capture software, capture 200 
an image of a critical feature within the phantom under a magnification that maximizes the 201 
feature within the field of view. 202 
 203 
2.4.2. Capture an image of an appropriate calibration reticle at the same magnification. 204 
 205 
2.4.3. Load both images into ImageJ by dragging them onto the Toolbar. 206 
 207 
2.4.4. Click on the calibration reticle image to make it active and, then, select the Line tool. Using 208 
the mouse, draw a line along a feature of a known distance and select Analyze > Set Scale from 209 
the ImageJ menu.  210 
 211 
NOTE: In the Set Scale window, the field labeled Distance in pixels should be prepopulated with 212 
the length of the drawn line in units of pixels. 213 
 214 
2.4.5. Enter the length of the feature in the field labeled Known Distance, and its unit in the field 215 
labeled Unit of Length. Check the box labeled Global to apply this calibration factor to all open 216 
images. 217 
 218 
2.4.6. Make the image of the phantom critical feature active and use the Line tool to draw a line 219 
along a feature of interest. From the ImageJ menu, select Analyze > Measure (or press Ctrl + M) 220 



   

 

to measure the length of the line. 221 
 222 
2.4.7. Compare the expected value against the value in the column marked Length in the Results 223 
window to confirm phantom fidelity. 224 
 225 
3. Mock Blood Solution Formulation 226 
 227 
3.1. Mix DI water and glycerol in a 60:40 ratio (by volume).  228 
 229 
NOTE: A 100 mL volume is sufficient for the in vitro circulatory system described herein. 230 
 231 
3.2. Add 1 mL of 2.5% w/v fluorescent polystyrene bead solution (i.e., tracer particles) to the 232 
mock blood solution.  233 
 234 
3.3.  Homogenize the mixture on a magnetic stir plate at 400 rpm for 10 min.  235 
 236 
4. In Vitro Circulatory System Set-up  237 
 238 
4.1. Pump set-up 239 
 240 
4.1.1. Use a wire stripper tool to cut off the DC-end plug from the AC-to-DC adapter power 241 
source.  242 
 243 
4.1.2. Strip the coating off the power and ground wires and connect them to the input terminal 244 
of the pulse width modulation (PWM) voltage regulator.  245 
 246 
4.1.3. Connect the power and ground wires from the pump’s DC motor to the output terminal of 247 
the PWM voltage regulator.  248 
 249 
NOTE: The PWM’s seven-segment display outputs the duty cycle (0% - 100%) used to achieve a 250 
variable voltage to the DC motor.  251 
 252 
4.2. Pump calibration 253 
 254 
4.2.1. Prepare 200 mL of mock blood solution (see section 3).  255 
 256 
4.2.2. Place tubing from the pump inlet to the beaker holding the mock blood solution. 257 
 258 
4.2.3. Place tubing from the pump outlet to an empty beaker. 259 
 260 
4.2.4. Select a desired duty cycle set point (0% - 100%). Press the On button and start a timer.  261 
 262 
4.2.5. Stop the timer once the pump has transferred the entire volume of mock blood solution. 263 
Use this time to calculate the volumetric flow rate. 264 



   

 

 265 
4.2.6. Repeat steps 4.2.1 - 4.2.5 for at least five different duty cycle set points to establish a least-266 
squares regression curve.  267 
 268 
NOTE: A minimum of three replicate points per duty cycle set point is recommended. This 269 
relationship can be used to correlate the desired flow rate to the required PWM duty cycle.  270 
 271 
5. Video Collection 272 
 273 
5.1. Image calibration 274 
 275 
5.1.1. Determine the calibration ratio for the video imaging (see section 2). 276 
 277 
5.2. Apparatus set-up 278 
 279 
5.2.1. Place the PDMS phantom on the stage of the fluorescence microscope. 280 
 281 
5.2.2. Connect the phantom to the gear pump and introduce the mock blood solution. 282 
 283 
NOTE: Optionally, prefill the model with ethanol to facilitate full wetting; then, flush and fill it 284 
with the mock blood solution. This may be particularly beneficial for models with smaller vessels 285 
and/or blind features.  286 
  287 
5.2.3. Set the pump motor controller for the desired flow rate based on the pump calibration 288 
curve. 289 
 290 
5.2.4. Run the pump for 1 - 5 min prior to the experiment to ensure steady-state conditions. 291 
 292 
5.2.5. Turn on the external lamp to illuminate the field of view. Select an appropriate filter based 293 
on the excitation wavelength of the fluorescent beads. 294 
 295 
5.2.6. Adjust the imaging focal plane to the vessel midplane.  296 
 297 
NOTE: This can be achieved by using a focal length that maximizes the imaged vessel cross-298 
section (e.g., when using phantoms with circular vessel cross sections); and/or indexing off of a 299 
phantom feature designed to facilitate the identification of the vessel mid-plane. 300 
 301 
5.3. Video recording 302 
 303 
5.3.1. Select the video recording parameters to optimize the signal-to-noise ratio (SNR). Key 304 
parameters include exposure time, frame rate, and gain.  305 
 306 
NOTE: In this protocol, we use a frame rate of 2,000 fps and a gain of 1.0. However, these 307 
parameters may vary based on the application (see the discussion section for further details).  308 



   

 

 309 
5.3.2. Collect the video and save it in AVI format. 310 
 311 
5.4. Phantom clean-up 312 
 313 
5.4.1. If bead-sticking is observed after an experiment, sonicate the phantom in an aqueous 314 
detergent solution using powers up to 70 W.  315 
 316 
6. Image Processing and Data Analysis 317 
 318 
6.1. Image preprocessing 319 
 320 
6.1.1. Drag the saved AVI file onto the ImageJ window to import it. Select the box marked Convert 321 
to Grayscale. 322 
 323 
6.1.2. From the ImageJ menu, select Analyze > Generate Histogram (or press Ctrl + H) to 324 
generate a histogram of image pixel intensities. Take note of the mean and standard deviation 325 
for the unprocessed image. 326 
 327 
NOTE: At high frame rates, it is not unusual for the distribution to be skewed heavily toward zero 328 
(i.e., no signal). 329 
 330 
6.1.3. From the ImageJ menu, select Image > Adjust > Brightness and Contrast (or press Shift + 331 
Ctrl + H) to apply a brightness/contrast filter.  332 
 333 
6.1.4. On the Brightness and Contrast menu, press the Set button to define the image limits. Set 334 
the minimum value to be the mean value plus one standard deviation, and the maximum value 335 
to be the maximum intensity of the image (both based on statistics obtained in step 6.1.2).  336 
 337 
NOTE: This typically eliminates all but the top 10% of the pixel intensities. The number of standard 338 
deviations may be varied depending on the desired distribution of the pixel intensities. A custom 339 
macro script for performing the intensity capping operation is provided in the Supplemental 340 
Materials. 341 
 342 
6.1.5. From the ImageJ menu, select Process > Noise > Despeckle to reduce the number of 343 
saturated pixels. 344 
 345 
NOTE: This operation is necessitated by the increased potential for pixel saturation that arises 346 
during the optimization of the brightness and contrast, which can produce spurious vectors 347 
during subsequent cross-correlation. 348 
 349 
6.1.6. From the ImageJ menu, select Process > Filters > Gaussian Blur with a radius of 1.5 to 350 
reduce artifacts arising from the occasional removal of illuminated pixels in a 3 x 3 neighborhood 351 
by the prior despeckling operation. 352 



   

 

 353 
6.1.7. Click on the Polygon tool and, then, click on the image to outline the region of interest 354 
(ROI).  355 
 356 
6.1.8. From the ImageJ menu, select Edit > Clear Outside to remove sensor noise in locations 357 
where no signal is expected (e.g., areas beyond the vessel wall boundary), which can decrease 358 
the overall SNR. 359 
 360 
6.2. PIV calculation 361 
 362 
NOTE: This portion of the protocol employs a third-party PIV plug-in for ImageJ, which relies upon 363 
Gaussian peak-fitting to enable an estimation of displacement with subpixel accuracy. 364 
 365 
6.2.1. From the ImageJ menu, select Plugins > Macros > Run… and navigate to the saved macro 366 
Supplemental Code 2.ijjm to cross-correlate successive image pairs.  367 
 368 
NOTE: The macro proceeds as follows. 1) A cross-correlation of the intensity field within 369 
consecutive images is first performed to determine the local displacement of advected tracer 370 
particles (i.e., the first image pair consists of the first and second images, the second image pair 371 
consists of the second and third images, etc.). 2) A two-step multipass evaluation is then 372 
performed with initial and final interrogation window sizes of 256 x 256 pixels and 128 x 128 373 
pixels, respectively. Finally, 3) the macro performs a temporal average to further reduce the 374 
appearance of spurious vectors. 375 
 376 
6.3. Normalized median test (NMT) 377 
 378 
6.3.1. From the ImageJ menu, select Plugins > Macros > Run… and navigate to the saved macro 379 
Supplemental Code 3.ijjm to validate the velocity fields via the normalized median test.  380 
 381 
NOTE: The macro proceeds as follows. 1) Each vector in an instantaneous vector field is first 382 
compared to its eight nearest neighbors to compute the median value. 2) The array of residual 383 
errors is then calculated as the difference between each neighboring vector and the calculated 384 
median. 3) The difference between the vector under investigation and the median neighboring 385 
vector value is then normalized by the median of the residuals. 4) This is then compared to a 386 
threshold value (typically, 0.2 pixels), which can be varied based on a priori knowledge of noise 387 
during the image acquisition. Finally, 5) a temporal average of all validated instantaneous vector 388 
fields is performed to produce a composite field, as this has been shown to increase the vector 389 
field quality24. 390 
 391 
REPRESENTATIVE RESULTS:  392 
Figure 2 illustrates the PDMS tissue phantom fabrication process. The phantoms designed herein 393 
are intended for the study of flow in idealized wide-necked, saccular, intracranial aneurysms, as 394 
well as proximal branching perforator arteries. Important additional design features include 1) a 395 
common reservoir that all vessels drain into, to ensure unencumbered fluid egress from the 396 



   

 

phantom—otherwise, droplet formation may occur at the smaller vessel outlets; 2) a bubble trap, 397 
to facilitate bubble removal; 3) an outer cavity wall, to ensure parallelism of the vessel with the 398 
horizontal plane, as well as a precise definition of the final phantom slab height, length, and 399 
width; 4) the use of a 21 G hypodermic needle shank (820 µm in nominal outer diameter) for the 400 
molding of the perforator artery, due to our printer’s inability to define such features with 401 
sufficient fidelity. Faithful reproduction of all design features is observed throughout. 402 
 403 
Representative results of a PIV-based flow characterization performed using the current protocol 404 
are presented in Figure 3 and Figure 4. These studies were performed using phantom inlet flow 405 
rates of 100 mL/min, data acquisition rates of 2,000 fps, and a temporal averaging over spans of 406 
0.05 s. Figure 3 shows representative image frames within the perforator artery, before and after 407 
intensity capping, as well as corresponding surface plots of the 8-bit pixel intensity values. Both 408 
demonstrate that intensity capping significantly increases the peak definition above the noise 409 
floor (i.e., increases the SNR), which is critical to ensuring accuracy when performing subsequent 410 
cross-correlation. Figure 4 shows the effects of intensity capping and NMT operations on the 411 
velocity vector field. Marked improvement in field uniformity is observed, thus further 412 
underscoring the importance of maximizing the SNR to minimize data dropout.  413 
 414 
FIGURE AND TABLE LEGENDS:  415 
 416 
Figure 1: Particle image velocimetry set-up. Reliance upon an open-source image analysis and a 417 
pre-/postprocessing framework reduces the demand upon the instrumentation for measuring 418 
mesoscale flows, thus eliminating the need for many of the costly components of typical PIV 419 
systems (e.g., pulsed laser, synchronizer, cylindrical optics, and/or proprietary software). 420 
  421 
Figure 2: PDMS-based tissue phantom fabrication process. The images illustrate (a) a CAD model 422 
of the neurovascular phantom mold, (b) the printed ABS mold after the removal of the support 423 
material, (c) the casting and curing of PDMS within the ABS mold, (d) partial dissolution of ABS 424 
mold material, and (e) the completed PDMS phantom, with the inset showing the final 425 
dimensions of critical features, as well as the region of interest (ROI) in the perforator artery 426 
where the PIV measurements were made.  427 
 428 
Figure 3: Effect of the intensity capping operation on the image SNR. These panels show 429 
representative image frames and the corresponding pixel intensity surface plots within the 430 
perforator artery, (a and b) before and (c and d) after applying the intensity capping operation. 431 
 432 
Figure 4: Effects of intensity capping and NMT operations on velocity vector fields. These panels 433 
illustrate the representative instantaneous velocity vector field within the perforator artery 434 
derived from (a) unprocessed image data, (b) intensity-capped data, and (c) intensity-capped 435 
data + NMT postprocessing.  436 
 437 
Figure 5: Effect of interrogation window sizing on correlation quality. Optimal window sizing 438 
occurs when the value of the zero-normalized correlation coefficient is maximized, and the 439 
standard deviation is minimized. 440 



   

 

 441 
DISCUSSION:  442 
The protocol described herein outlines a simplified method for performing PIV studies to visualize 443 
neurovascular flows at physiologically relevant dimensions and flow conditions in vitro. In doing 444 
so, it serves to complement protocols reported by others that have also focused on simplifying 445 
the quantification of vector fields, but within very different contexts that require the 446 
consideration of far larger length scales25 or lower flow rates26,27 (e.g., atmospheric or 447 
microcirculatory flows), and thus, with a reliance upon schemes that are incompatible with the 448 
current application.  449 
 450 
The most important considerations for the successful implementation of PIV lie in the 451 
minimization of flow field artifacts and the maximization of image quality. Several steps in the 452 
tissue phantom fabrication process are critical to both of these criteria. For example, thorough 453 
degassing is crucial since air entrained within the PDMS during mixing can lead to bubble 454 
formation within the final phantom, which can adversely affect both feature fidelity and optical 455 
clarity. Additionally, minimization of surface roughness of the ABS mold is desired, since the 456 
PDMS casting process faithfully reproduces even the most minute imperfections (e.g., build lines, 457 
surface pores, scratches), thus resulting in surface roughness in the final phantom that can 458 
decrease optical clarity and increase the potential for bead accumulation. While the protocol 459 
described herein has proven sufficient for the current application, there are numerous reports in 460 
the literature of means of reducing such roughness, should there be any need (e.g., acetone 461 
vapor smoothing28 or the optimization of layer thickness and part orientation with respect to the 462 
building direction)29. 463 
 464 
The parameter selection for video capture is also critical to ensure a high-fidelity vector field. An 465 
optimal SNR is typically achieved at the highest achievable frame rate that still allows sufficient 466 
bead exposure (the maximum frame rate being limited by the minimum exposure time). Gain can 467 
be used to amplify the signal, but this also increases sensor noise. If the maximum velocity can 468 
be estimated from other flow parameters (e.g., inlet volumetric flow rate), then a lower bound 469 
on the required frame rate can be estimated using the following relation30. 470 
 471 

𝑓𝑠𝑎𝑚𝑝𝑙𝑖𝑛𝑔 >
𝑣𝑚𝑎𝑥 × 𝑐𝑐𝑎𝑙𝑖𝑏𝑟𝑎𝑡𝑖𝑜𝑛

ℎ𝑖𝑛𝑡𝑒𝑟𝑟𝑜𝑔𝑎𝑡𝑖𝑜𝑛 𝑤𝑖𝑛𝑑𝑜𝑤
 (1) 472 

 473 
Here, fsampling is the camera acquisition rate (Hz), vmax is the maximum expected velocity (mm/s), 474 
ccalibration is the calibration constant (pixels/mm), and hinterrogation window is the size of the 475 
interrogation window (pixels). However, more optimal values can be determined using so-called 476 
correlation quality estimation techniques, such as the zero-normalized correlation coefficient11. 477 
In this technique, the averages of complementary signals from each frame pair are first 478 
subtracted and, then, normalized by the standard deviation of their intensities11. If a 479 
displacement of the original signal exists, such that all peaks and valleys match, the time-shifted 480 
value of this signal will be equal to one. Conversely, if there is no displacement that can align 481 
these signals, the value will be zero. This information is included in the ImageJ PIV output for 482 
each vector, and it can be plotted as its own field to verify whether there are spatial effects 483 



   

 

contributing to poor correlation (e.g., uneven lighting). The correlation coefficient can also be 484 
averaged over a field as an overall estimate of its quality. Finally, this quantity may also be plotted 485 
against varying frame rates or interrogation window sizes to determine an optimum. Figure 5 486 
illustrates the results from such an analysis using a Monte Carlo-synthesized particle field with 487 
displacements consistent with our experimentally measured flows (a typical technique for 488 
characterizing correlation quality11). The results show that the interrogation window size and 489 
frame rate should be chosen such that a particle field is displaced by ≤ 20% of the interrogation 490 
window size per frame pair to maximize the correlation coefficient while minimizing its 491 
variability.  492 
 493 
Although the protocol described herein has proven sufficient for meeting the needs of the 494 
current application, it is important to acknowledge its limitations. For example, while contrast 495 
enhancement via intensity capping offers ease of implementation, transformations of the entire 496 
distribution of pixel intensities may improve the SNR further31. Similarly, although correlation-497 
based tracking is well established and provides sufficient resolution for reliably estimating first-498 
order flow characteristics relevant to hemodynamics (e.g., intra-aneurysmal velocity), other 499 
techniques may offer a higher spatial resolution (e.g., hybrid PIV/PTV, least-squares 500 
matching)32,33 and, thus, greater accuracy when considering characteristics that are more 501 
sensitive to the velocity field resolution (e.g., wall shear stress, in-plane vorticity). Likewise, while 502 
the NMT provides a means for improving the velocity vector field after cross-correlation, it is 503 
important to emphasize that this is just one of many vector validation techniques that could be 504 
used24,34, each with their own unique advantages and disadvantages that may make their use 505 
more suitable for applications beyond those described here. Lastly, while the experimental set-506 
up described here seeks to mimic physiologically relevant flow rates and length scales for the 507 
neurovasculature, it does not currently allow the analysis of pulsatile flows. This has not been a 508 
limitation for the current application, since the range of Womersley numbers in much of the 509 
neurovasculature tends to be ≤ 1 (i.e., there is a minimal additive effect of multiple cardiac 510 
cycles)35, which suggests that steady-state conditions are sufficient to recapitulate discrete time 511 
points along the cardiac waveform in which the flow rate is comparable. However, for 512 
applications where the Womersley number is larger (e.g., vasculature closer to the heart), we 513 
envision a potential for introducing pulsatility through the use of an Arduino, which could be used 514 
to send the pump a time-varying PWM voltage waveform that enables the mimicking of a cardiac 515 
flow profile36-38. 516 
 517 
ACKNOWLEDGMENTS:  518 
The authors acknowledge partial support for this project provided by a Collaborative Seed Grant 519 
from the Office of Research and Economic Development at UC Riverside. 520 
 521 
DISCLOSURES:  522 
The authors have nothing to declare. 523 
 524 
REFERENCES  525 
1. Grant, I. Particle image velocimetry: A review. Proceedings of the Institution of Mechanical 526 
Engineers, Part C: Journal of Mechanical Engineering Science. 211 (1), 55-76, doi: 527 



   

 

10.1243/0954406971521665 (1997). 528 
 529 
2. Lindken, R., Rossi, M., Große, S., Westerweel, J. Micro-Particle Image Velocimetry (µPIV): 530 
Recent developments, applications, and guidelines. Lab on a Chip. 9 (17), 2551, doi: 531 
10.1039/b906558j (2009). 532 
 533 
3. Hove, J.R. et al. Intracardiac fluid forces are an essential epigenetic factor for embryonic 534 
cardiogenesis. Nature. 421, 172 (2003). 535 
 536 
4. Ando, J., Yamamoto, K. Vascular Mechanobiology. Circulation Journal. 73 (11), 1983-1992, doi: 537 
10.1253/circj.CJ-09-0583 (2009). 538 
 539 
5. Conway, D.E. et al. Fluid Shear Stress on Endothelial Cells Modulates Mechanical Tension 540 
across VE-Cadherin and PECAM-1. Current Biology. 23 (11) (2013). 541 
 542 
6. Kuhlencordt, P.J. et al. Accelerated Atherosclerosis, Aortic Aneurysm Formation, and Ischemic 543 
Heart Disease in Apolipoprotein E/Endothelial Nitric Oxide Synthase Double-Knockout Mice. 544 
Circulation. 104 (4), 448-454, doi: 10.1161/hc2901.091399 (2001). 545 
 546 
7. Lieber, B.B., Stancampiano, A.P., Wakhloo, A.K. Alteration of hemodynamics in aneurysm 547 
models by stenting: Influence of stent porosity. Annals of Biomedical Engineering. 25 (3), 460-548 
469, doi: 10.1007/BF02684187 (1997). 549 
 550 
8. Bulusu, K. V., Plesniak, M.W. Experimental Investigation of Secondary Flow Structures 551 
Downstream of a Model Type IV Stent Failure in a 180˚ Curved Artery Test Section. Journal of 552 
Visualized Experiments. (113), e51288, doi: 10.3791/51288 (2016). 553 
 554 
9. Tseng, Q. et al. Spatial organization of the extracellular matrix regulates cell-cell junction 555 
positioning. Proceedings of the National Academy of Sciences of the United States of America. 556 
109 (5), 1506-1511, doi: 10.1073/pnas.1106377109 (2012). 557 
 558 
10. Shavit, U., Lowe, R.J., Steinbuck, J. V Intensity Capping: a simple method to improve cross-559 
correlation PIV results. Experiments in Fluids. 42 (2), 225-240, doi: 10.1007/s00348-006-0233-7 560 
(2007). 561 
 562 
11. Raffel, M., Willert, C.E., Werely, S., Kompenhans, J. Particle Image Velocimetry: a Practical 563 
Guide. Springer. New York, NY (2007). 564 
 565 
12. Kerl, H.U. et al. Implantation of Pipeline Flow-Diverting Stents Reduces Aneurysm Inflow 566 
Without Relevantly Affecting Static Intra-aneurysmal Pressure. Neurosurgery. 74 (3), 321-334 567 
(2014). 568 
 569 
13. Lieber, B.B., Livescu, V., Hopkins, L.N., Wakhloo, A.K. Particle Image Velocimetry Assessment 570 
of Stent Design Influence on Intra-Aneurysmal Flow. Annals of Biomedical Engineering. 30 (6), 571 



   

 

768-777, doi: 10.1114/1.1495867 (2002). 572 
 573 
14. Charonko, J., Karri, S., Schmieg, J., Prabhu, S., Vlachos, P. In vitro, time-resolved PIV 574 
comparison of the effect of stent design on wall shear stress. Annals of Biomedical Engineering. 575 
37 (7), 1310-1321, doi: 10.1007/s10439-009-9697-y (2009). 576 
 577 
15. Rand, P.W., Lacombe, E., Hunt, H.E., Austin, W.H. Viscosity of normal human blood under 578 
normothermic and hypothermic conditions. Journal of Applied Physiology. 19 (1), 117-122, doi: 579 
10.1152/jappl.1964.19.1.117 (1964). 580 
 581 
16. Kenner, T., Leopold, H., Hinghofer-Szalkay, H. The continuous high-precision measurement of 582 
the density of flowing blood. Pflügers Archiv European Journal of Physiology. 370 (1), 25-29, doi: 583 
10.1007/BF00707941 (1977). 584 
 585 
17. Hoyt, L.F. New Table of the Refractive Index of Pure Glycerol at 20°C. Industrial & Engineering 586 
Chemistry. 26 (3), 329-332, doi: 10.1021/ie50291a023 (1934). 587 
 588 
18. Cai, Z., Qiu, W., Shao, G., Wang, W. A new fabrication method for all-PDMS waveguides. 589 
Sensors and Actuators A: Physical. 204, 44-47 (2013). 590 
 591 
19. Bouillot, P. et al. Particle imaging velocimetry evaluation of intracranial stents in sidewall 592 
aneurysm: hemodynamic transition related to the stent design. PloS ONE. 9 (12), e113762, doi: 593 
10.1371/journal.pone.0113762 (2014). 594 
 595 
20. Trager, A.L., Sadasivan, C., Lieber, B.B. Comparison of the in vitro hemodynamic performance 596 
of new flow diverters for bypass of brain aneurysms. Journal of Biomechanical Engineering. 134 597 
(8), 084505, doi: 10.1115/1.4006454 (2012). 598 
 599 
21. Clauser, J. et al. A Novel Plasma-Based Fluid for Particle Image Velocimetry (PIV): In-Vitro 600 
Feasibility Study of Flow Diverter Effects in Aneurysm Model. Annals of Biomedical Engineering. 601 
46 (6), 841-848, doi: 10.1007/s10439-018-2002-1 (2018). 602 
 603 
22. Johnston, I.D., McCluskey, D.K., Tan, C.K.L., Tracey, M.C. Mechanical characterization of bulk 604 
Sylgard 184 for microfluidics and microengineering. Journal of Micromechanics and 605 
Microengineering. 24 (3), 035017, doi: 10.1088/0960-1317/24/3/035017 (2014). 606 
 607 
23. Lee, J.N., Park, C., Whitesides, G.M. Solvent Compatibility of Poly(dimethylsiloxane)-Based 608 
Microfluidic Devices. Analytical Chemistry. 75 (23), 6544-6554, doi: 10.1021/ac0346712 (2003). 609 
 610 
24. Meinhart, C.D., Wereley, S.T., Santiago, J.G. A PIV Algorithm for Estimating Time-Averaged 611 
Velocity Fields. Journal of Fluids Engineering. 122 (2), 285, doi: 10.1115/1.483256 (2000). 612 
 613 
25. Bosbach, J., Kühn, M., Wagner, C., Raffel, M., Resagk, C. Large-Scale Particle Image 614 
Velocimetry of Natural and Mixed Convection. 13th Int Symp on Applications of Laser Techniques 615 



   

 

to Fluid Mechanics (2006). 616 
 617 
26. Meinhart, C.D., Wereley, S.T., Santiago, J.G. PIV measurements of a microchannel flow. 618 
Experiments in Fluids. 27 (5), 414-419, doi: 10.1007/s003480050366 (1999). 619 
 620 
27. Lima, R. et al. In vitro blood flow in a rectangular PDMS microchannel: experimental 621 
observations using a confocal micro-PIV system. Biomedical Microdevices. 10 (2), 153-167, doi: 622 
10.1007/s10544-007-9121-z (2008). 623 
 624 
28. Kuo, C.-C., Mao, R.-C. Development of a Precision Surface Polishing System for Parts 625 
Fabricated by Fused Deposition Modeling. Materials and Manufacturing Processes. 31 (8), 1113-626 
1118, doi: 10.1080/10426914.2015.1090594 (2016). 627 
 628 
29. Kang, K., Oh, S., Yi, H., Han, S., Hwang, Y. Fabrication of truly 3D microfluidic channel using 629 
3D-printed soluble mold. Biomicrofluidics. 12 (1), 014105, doi: 10.1063/1.5012548 (2018). 630 
 631 
30. Prasad, A.K. Particle Image Velocimetry. Current Science. 79 (1), 51-60 (2000). 632 
 633 
31. Dellenback, P.A., Macharivilakathu, J., Pierce, S.R. Contrast-enhancement techniques for 634 
particle-image velocimetry. Applied Optics. 39 (32), 5978-5990, doi: 10.1364/AO.39.005978 635 
(2000). 636 
 637 
32. Cowen, E.A., Monismith, S.G. A hybrid digital particle tracking velocimetry technique. 638 
Experiments in Fluids. 22 (3), 199-211 (1997). 639 
 640 
33. Gruen, A.W. Adaptive least squares correlation: a powerful image matching technique. South 641 
African Journal of Photogrammetry, Remote Sensing and Cartography. 14 (3), 175-187 (1985). 642 
 643 
34. Nogueira, J., Lecuona, A., Rodríguez, P.A. Data validation, false vectors correction and derived 644 
magnitudes calculation on PIV data. Measurement Science and Technology. 8 (12), 1493-1501, 645 
doi: 10.1088/0957-0233/8/12/012 (1997). 646 
 647 
35. Loudon, C., Tordesillas, A. The Use of the Dimensionless Womersley Number to Characterize 648 
the Unsteady Nature of Internal Flow. Journal of Theoretical Biology. 191 (1), 63-78 (1998). 649 
 650 
36. Drost, S., De Kruif, B.J., Newport, D. Arduino control of a pulsatile flow rig. Medical 651 
Engineering and Physics. 51, 67-71, doi: 10.1016/j.medengphy.2017.10.006 (2017). 652 
 653 
37. Tsai, W., Savaş, Ö. Flow pumping system for physiological waveforms. Medical & Biological 654 
Engineering & Computing. 48 (2), 197-201, doi: 10.1007/s11517-009-0573-6 (2010). 655 
 656 
38. Kato, T. et al. Contrast-enhanced 2D cine phase MR angiography for measurement of basilar 657 
artery blood flow in posterior circulation ischemia. American Journal of Neuroradiology. 23 (8), 658 
1346-1351 (2002). 659 



   

 

 660 



High Speed
Camera

PDMS-based 
Phantom

Computer

Microscope
Objectives

Recirculating
Pump

Topside
Illuminator

Figure 1 Click here to
access/download;Figure;Figure1.pd

http://www.editorialmanager.com/jove/download.aspx?id=898886&guid=b1f04990-d806-4ea6-bd9b-238cc9c45334&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=898886&guid=b1f04990-d806-4ea6-bd9b-238cc9c45334&scheme=1


Reservoir

Outlet

Inlet

Bubble Trap

Parent Artery Aneurysm 
Sac

a)

e)

Perforator mold feature 
(hypo tube)

b)

d)

c)

Ø 820 µm

Ø 3 mm

Ø 6.5 mm

10 mm

Region of Interest

Figure 2 Click here to
access/download;Figure;Figure2.pdf

http://www.editorialmanager.com/jove/download.aspx?id=899506&guid=b155fe4c-22d1-4c28-a2a9-b47116555ce5&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=899506&guid=b155fe4c-22d1-4c28-a2a9-b47116555ce5&scheme=1


a) b)

c) d)

Figure 3 Click here to
access/download;Figure;Figure3.pd

http://www.editorialmanager.com/jove/download.aspx?id=899507&guid=5f45b44a-01e6-4154-ba0a-1cb2da72e346&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=899507&guid=5f45b44a-01e6-4154-ba0a-1cb2da72e346&scheme=1


170

136

102

68

34

V
el

o
ci

ty
 (

m
m

/s
)

b
)

c
)

a) b) c)Figure 4 Click here to
access/download;Figure;Figure4.pdf

http://www.editorialmanager.com/jove/download.aspx?id=899508&guid=2ba7cd1d-79db-4597-a74d-cde8e8e64ddc&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=899508&guid=2ba7cd1d-79db-4597-a74d-cde8e8e64ddc&scheme=1


Figure 5 Click here to
access/download;Figure;Figure5.pdf

http://www.editorialmanager.com/jove/download.aspx?id=898887&guid=bb2bd35a-2fdd-4f46-ada7-3ad3c72df421&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=898887&guid=bb2bd35a-2fdd-4f46-ada7-3ad3c72df421&scheme=1


Name of Material/ Equipment Company Catalog Number

Solidworks 2015 Dassault Systems N/A

Dow Corning Sylgard 184 Kit Ellsworth Adhesive 184 SIL ELAST KIT 3.9KG

Stratasys Dimension Elite Stratasys 9180-00105

P430 Model Material Cartridge Stratasys 340-21202

P400 SR Soluble Support Material Cartridge Stratasys 340-30200

CleanStation DT3 PM3 Technologies 00-00300R

Lindberg Blue M LGO Box Furnace Thermo Scientific LB305745M

21G BD PrecisionGlide Needle Betcon Dickenson BD 305167

Desiccator (Vacuum) Polylab 55205

Branson 1800 Utrasonic Cleaning Branson CPX-952-116R

Acetone Fisher Chemical A9494

Isopropol Alcohol Fisher Chemical A4514

Glycerol Fisher Chemical GW33500

10um Polystyrene Yellow-Green Fluorescent Particles Magsphere PSF-010UM

Phantom Miro Vision Research Miro M310

Micropump Cole-Parmer 81101

Leica DM2000 Leica Microsystems DM2000

Leica 10X Objective Leica Microsystems 506259

Leica 2.5X Objective Leica Microsystems 11506083

Leica Blue Filter Cube L5 Leica Microsystems 513840

Leica EL6000 Leica Microsystems 11504115

Alconox Alconox Inc 1104-1

ImageJ NIH N/A

Particle Image Velocimetry PIV Plugin Qingson Tseng N/A

Table of Materials Click here to access/download;Table of Materials;Table of Materials.xls

http://www.editorialmanager.com/jove/download.aspx?id=898888&guid=dea011ec-f17f-4756-acb1-a891da7de317&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=898888&guid=dea011ec-f17f-4756-acb1-a891da7de317&scheme=1


Comments/Description

CAD Software 

PDMS Kit

3D printer

ABS build material 

Support material

Base bath

Oven

Branching perforator mold segment

Desiccator

Sonicator

Acetone

Isopropol Alcohol

Glycerol

Fluorescent beads

High speed camera

Recirculating pump

Fluorescent Microscope

Objective for perforator

Objective aneurysm sac

Blue filter cube

Light source

Detergent

Open source image analysis software

https://sites.google.com/site/qingzongtseng/piv



ARTICLE AND VIDEO LICENSE AGREEMENT 
 

612542.6 For questions, please contact us at submissions@jove.com or +1.617.945.9051. 

Title of Article:  
 
Author(s):  
 
 
Item 1: The Author elects to have the Materials be made available (as described at 
http://www.jove.com/publish) via: 

 Standard Access   Open Access
 
Item 2: Please select one of the following items: 

 The Author is NOT a United States government employee. 

 The Author is a United States government employee and the Materials were prepared in the 
course of his or her duties as a United States government employee. 

 The Author is a United States government employee but the Materials were NOT prepared in the 
course of his or her duties as a United States government employee. 

 
ARTICLE AND VIDEO LICENSE AGREEMENT 

 
1. Defined Terms. As used in this Article and Video 
License Agreement, the following terms shall have the 
following meanings: “Agreement” means this Article and 
Video License Agreement; “Article” means the article 
specified on the last page of this Agreement, including any 
associated materials such as texts, figures, tables, artwork, 
abstracts, or summaries contained therein; “Author” 
means the author who is a signatory to this Agreement; 
“Collective Work” means a work, such as a periodical issue, 
anthology or encyclopedia, in which the Materials in their 
entirety in unmodified form, along with a number of other 
contributions, constituting separate and independent 
works in themselves, are assembled into a collective whole; 
“CRC License” means the Creative Commons Attribution-
Non Commercial-No Derivs 3.0 Unported Agreement, the 
terms and conditions of which can be found at: 
http://creativecommons.org/licenses/by-nc-
nd/3.0/legalcode; “Derivative Work” means a work based 
upon the Materials or upon the Materials and other pre-
existing works, such as a translation, musical arrangement, 
dramatization, fictionalization, motion picture version, 
sound recording, art reproduction, abridgment, 
condensation, or any other form in which the Materials may 
be recast, transformed, or adapted; “Institution” means 
the institution, listed on the last page of this Agreement, by 
which the Author was employed at the time of the creation 
of the Materials; “JoVE” means MyJove Corporation, a 
Massachusetts corporation and the publisher of The Journal 
of Visualized Experiments; “Materials” means the Article 
and / or the Video; “Parties” means the Author and JoVE; 
“Video” means any video(s) made by the Author, alone or 
in conjunction with any other parties, or by JoVE or its 
affiliates or agents, individually or in collaboration with the 
Author or any other parties, incorporating all or any portion 

of the Article, and in which the Author may or may not 
appear. 
2. Background. The Author, who is the author of the 
Article, in order to ensure the dissemination and protection 
of the Article, desires to have the JoVE publish the Article 
and create and transmit videos based on the Article. In 
furtherance of such goals, the Parties desire to memorialize 
in this Agreement the respective rights of each Party in and 
to the Article and the Video. 
3. Grant of Rights in Article. In consideration of JoVE 
agreeing to publish the Article, the Author hereby grants to 
JoVE, subject to Sections 4 and 7 below, the exclusive, 
royalty-free, perpetual (for the full term of copyright in the 
Article, including any extensions thereto) license (a) to 
publish, reproduce, distribute, display and store the Article 
in all forms, formats and media whether now known or 
hereafter developed (including without limitation in print, 
digital and electronic form) throughout the world, (b) to 
translate the Article into other languages, create 
adaptations, summaries or extracts of the Article or other 
Derivative Works (including, without limitation, the Video) 
or Collective Works based on all or any portion of the Article 
and exercise all of the rights set forth in (a) above in such 
translations, adaptations, summaries, extracts, Derivative 
Works or Collective Works and(c) to license others to do any 
or all of the above. The foregoing rights may be exercised in 
all media and formats, whether now known or hereafter 
devised, and include the right to make such modifications 
as are technically necessary to exercise the rights in other 
media and formats. If the “Open Access” box has been 
checked in Item 1 above, JoVE and the Author hereby grant 
to the public all such rights in the Article as provided in, but 
subject to all limitations and requirements set forth in, the 
CRC License. 

 

 

Simplified protocol for meso-scale particle image velocimetry studies of 
neurovascular flows in vitro

Ryan A. Peck, Edver Bahena, Reza Jahan, Guillermo Aguilar, Hideaki Tsutsui 
Marko Princevac, Monica M. Wilhelmus, and Masaru P. Rao

Author License Agreement Click here to access/download;Author License Agreement
(ALA);Author_License_Agreement (MPR)-signed.pdf

http://www.editorialmanager.com/jove/download.aspx?id=898889&guid=d1307257-3405-4650-b6c7-6cefcbe5c13c&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=898889&guid=d1307257-3405-4650-b6c7-6cefcbe5c13c&scheme=1


ARTICLE AND VIDEO LICENSE AGREEMENT 
 

612542.6 For questions, please contact us at submissions@jove.com or +1.617.945.9051. 

4. Retention of Rights in Article. Notwithstanding 
the exclusive license granted to JoVE in Section 3 above, the 
Author shall, with respect to the Article, retain the non-
exclusive right to use all or part of the Article for the non-
commercial purpose of giving lectures, presentations or 
teaching classes, and to post a copy of the Article on the 
Institution’s website or the Author’s personal website, in 
each case provided that a link to the Article on the JoVE 
website is provided and notice of JoVE’s copyright in the 
Article is included. All non-copyright intellectual property 
rights in and to the Article, such as patent rights, shall 
remain with the Author. 
5. Grant of Rights in Video – Standard Access. This 
Section 5 applies if the “Standard Access” box has been 
checked in Item 1 above or if no box has been checked in 
Item 1 above. In consideration of JoVE agreeing to produce, 
display or otherwise assist with the Video, the Author 
hereby acknowledges and agrees that, Subject to Section 7 
below, JoVE is and shall be the sole and exclusive owner of 
all rights of any nature, including, without limitation, all 
copyrights, in and to the Video. To the extent that, by law, 
the Author is deemed, now or at any time in the future, to 
have any rights of any nature in or to the Video, the Author 
hereby disclaims all such rights and transfers all such rights 
to JoVE. 
6. Grant of Rights in Video – Open Access. This 
Section 6 applies only if the “Open Access” box has been 
checked in Item 1 above. In consideration of JoVE agreeing 
to produce, display or otherwise assist with the Video, the 
Author hereby grants to JoVE, subject to Section 7 below, 
the exclusive, royalty-free, perpetual (for the full term of 
copyright in the Article, including any extensions thereto) 
license (a) to publish, reproduce, distribute, display and 
store the Video in all forms, formats and media whether 
now known or hereafter developed (including without 
limitation in print, digital and electronic form) throughout 
the world, (b) to translate the Video into other languages, 
create adaptations, summaries or extracts of the Video or 
other Derivative Works or Collective Works based on all or 
any portion of the Video and exercise all of the rights set 
forth in (a) above in such translations, adaptations, 
summaries, extracts, Derivative Works or Collective Works 
and (c) to license others to do any or all of the above. The 
foregoing rights may be exercised in all media and formats, 
whether now known or hereafter devised, and include the 
right to make such modifications as are technically 
necessary to exercise the rights in other media and formats. 
For any Video to which this Section 6 is applicable, JoVE and 
the Author hereby grant to the public all such rights in the 
Video as provided in, but subject to all limitations and 
requirements set forth in, the CRC License. 
7. Government Employees. If the Author is a United 
States government employee and the Article was prepared 
in the course of his or her duties as a United States 
government employee, as indicated in Item 2 above, and 
any of the licenses or grants granted by the Author 
hereunder exceed the scope of the 17 U.S.C. 403, then the 
rights granted hereunder shall be limited to the maximum 

rights permitted under such statute. In such case, all 
provisions contained herein that are not in conflict with 
such statute shall remain in full force and effect, and all 
provisions contained herein that do so conflict shall be 
deemed to be amended so as to provide to JoVE the 
maximum rights permissible within such statute. 
8. Protection of the Work. The Author(s) authorize 
JoVE to take steps in the Author(s) name and on their behalf 
if JoVE believes some third party could be infringing or 
might infringe the copyright of either the Author’s Article 
and/or Video. 
9. Likeness, Privacy, Personality. The Author hereby 
grants JoVE the right to use the Author’s name, voice, 
likeness, picture, photograph, image, biography and 
performance in any way, commercial or otherwise, in 
connection with the Materials and the sale, promotion and 
distribution thereof. The Author hereby waives any and all 
rights he or she may have, relating to his or her appearance 
in the Video or otherwise relating to the Materials, under 
all applicable privacy, likeness, personality or similar laws. 
10. Author Warranties. The Author represents and 
warrants that the Article is original, that it has not been 
published, that the copyright interest is owned by the 
Author (or, if more than one author is listed at the beginning 
of this Agreement, by such authors collectively) and has not 
been assigned, licensed, or otherwise transferred to any 
other party. The Author represents and warrants that the 
author(s) listed at the top of this Agreement are the only 
authors of the Materials. If more than one author is listed 
at the top of this Agreement and if any such author has not 
entered into a separate Article and Video License 
Agreement with JoVE relating to the Materials, the Author 
represents and warrants that the Author has been 
authorized by each of the other such authors to execute this 
Agreement on his or her behalf and to bind him or her with 
respect to the terms of this Agreement as if each of them 
had been a party hereto as an Author. The Author warrants 
that the use, reproduction, distribution, public or private 
performance or display, and/or modification of all or any 
portion of the Materials does not and will not violate, 
infringe and/or misappropriate the patent, trademark, 
intellectual property or other rights of any third party. The 
Author represents and warrants that it has and will 
continue to comply with all government, institutional and 
other regulations, including, without limitation all 
institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy, and all other rules, regulations, 
laws, procedures or guidelines, applicable to the Materials, 
and that all research involving human and animal subjects 
has been approved by the Author's relevant institutional 
review board. 
11. JoVE Discretion. If the Author requests the 
assistance of JoVE in producing the Video in the Author’s 
facility, the Author shall ensure that the presence of JoVE 
employees, agents or independent contractors is in 
accordance with the relevant regulations of the Author's 
institution. If more than one author is listed at the 
beginning of this Agreement, JoVE may, in its sole 
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discretion, elect not take any action with respect to the 
Article until such time as it has received complete, executed 
Article and Video License Agreements from each such 
author. JoVE reserves the right, in its absolute and sole 
discretion and without giving any reason therefore, to 
accept or decline any work submitted to JoVE. JoVE and its 
employees, agents and independent contractors shall have 
full, unfettered access to the facilities of the Author or of 
the Author’s institution as necessary to make the Video, 
whether actually published or not. JoVE has sole discretion 
as to the method of making and publishing the Materials, 
including, without limitation, to all decisions regarding 
editing, lighting, filming, timing of publication, if any, 
length, quality, content and the like.  
12. Indemnification. The Author agrees to indemnify 
JoVE and/or its successors and assigns from and against any 
and all claims, costs, and expenses, including attorney’s 
fees, arising out of any breach of any warranty or other 
representations contained herein. The Author further 
agrees to indemnify and hold harmless JoVE from and 
against any and all claims, costs, and expenses, including 
attorney’s fees, resulting from the breach by the Author of 
any representation or warranty contained herein or from 
allegations or instances of violation of intellectual property 
rights, damage to the Author’s or the Author’s institution’s 
facilities, fraud, libel, defamation, research, equipment, 
experiments, property damage, personal injury, violations 
of institutional, laboratory, hospital, ethical, human and 
animal treatment, privacy or other rules, regulations, laws, 
procedures or guidelines, liabilities and other losses or 
damages related in any way to the submission of work to 
JoVE, making of videos by JoVE, or publication in JoVE or 
elsewhere by JoVE. The Author shall be responsible for, and 
shall hold JoVE harmless from, damages caused by lack of 
sterilization, lack of cleanliness or by contamination due to 

the making of a video by JoVE its employees, agents or 
independent contractors. All sterilization, cleanliness or 
decontamination procedures shall be solely the 
responsibility of the Author and shall be undertaken at the 
Author’s expense. All indemnifications provided herein 
shall include JoVE’s attorney’s fees and costs related to said 
losses or damages. Such indemnification and holding 
harmless shall include such losses or damages incurred by, 
or in connection with, acts or omissions of JoVE, its 
employees, agents or independent contractors. 
13. Fees. To cover the cost incurred for publication, 
JoVE must receive payment before production and 
publication the Materials. Payment is due in 21 days of 
invoice. Should the Materials not be published due to an 
editorial or production decision, these funds will be 
returned to the Author. Withdrawal by the Author of any 
submitted Materials after final peer review approval will 
result in a US$1,200 fee to cover pre-production expenses 
incurred by JoVE. If payment is not received by the 
completion of filming, production and publication of the 
Materials will be suspended until payment is received. 
14. Transfer, Governing Law. This Agreement may be 
assigned by JoVE and shall inure to the benefits of any of 
JoVE’s successors and assignees. This Agreement shall be 
governed and construed by the internal laws of the 
Commonwealth of Massachusetts without giving effect to 
any conflict of law provision thereunder. This Agreement 
may be executed in counterparts, each of which shall be 
deemed an original, but all of which together shall be 
deemed to me one and the same agreement. A signed copy 
of this Agreement delivered by facsimile, e-mail or other 
means of electronic transmission shall be deemed to have 
the same legal effect as delivery of an original signed copy 
of this Agreement.
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Editorial and Reviewers’ comments and Author responses (JoVE 58902) 
 
The Editorial and Reviewers’ comments are italicized below. They are included verbatim and in their 
entirety. Our corresponding responses are bolded. 
 
Editorial comments and Author responses: 
“1. Please take this opportunity to thoroughly proofread the manuscript to ensure that there are no 
spelling or grammar issues.” 

Done. 
 
“2. Please provide an email address for each author.” 

Done. 
 

“3. Please adjust the numbering of the Protocol to follow the JoVE Instructions for Authors. For example, 
1 should be followed by 1.1 and then 1.1.1 and 1.1.2 if necessary. Please refrain from using bullets, dashes, 
or indentations.” 

Done. Please note that this required wholesale revision of the protocol section. As such, the other 
changes made in this section in response to the Editorial & Reviewer’s comments are not 
distinguishable from the original text in the marked up copy of the revised manuscript (i.e., entire 
protocol section is marked as changed). 

 
“4. Please revise the protocol to contain only action items that direct the reader to do something (e.g., “Do 
this,” “Ensure that,” etc.). The actions should be described in the imperative tense in complete sentences 
wherever possible. Avoid usage of phrases such as “could be,” “should be,” and “would be” throughout 
the Protocol. Any text that cannot be written in the imperative tense may be added as a “Note.” Please 
include all safety procedures and use of hoods, etc. However, notes should be used sparingly and actions 
should be described in the imperative tense wherever possible.” 

Done. 
  
“5. Please add more details to your protocol steps. There should be enough detail in each step to 
supplement the actions seen in the video so that viewers can easily replicate the protocol. Please ensure 
you answer the “how” question, i.e., how is the step performed? Alternatively, add references to published 
material specifying how to perform the protocol action. See examples below: 

“1.1: Unclear what we can film here. Please describe the specific actions that are being performed 
here, otherwise please do not highlight this step for filming.” 

We have elected to remove the CAD model design and 3D printing portions from the filming 
segment to allow for more detailed elaboration of the other aspects of the protocol.  
 

“Line 120: Is the ratio by weight or by volume? Please specify the volume/mass of the mixture prepared 
here.” 

We have provided further details in this regard in Section 2.1.1 of the revised manuscript. 
 

“Line 140: Please describe how to confirm fidelity. What are observed here?” 
We have provided further details in this regard in Section 2.4 of the revised manuscript. 
 

“3.2: How many fluorescent polystyrene beads are added and where are they added?” 
We have provided further details in this regard in Section 3.2 of the revised manuscript. 
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“Line 166: What is used to capture an image?” 

We have provided further details in this regard in Section 5.1 of the revised manuscript. 
 

“Line 211: What detergent is used? Please also mention the sonication power used.” 
The detergent (Alconox) was specified in the Table of Materials document included in the 
original manuscript package. However, this may have been missed, since the table’s description 
column was pushed to the second page of the document. 
 
Sonication power is not user-definable for the ultrasonic cleaner used herein. However, the 
stated maximum sonication power for this system is 70 W. We have provided further details in 
this regard in Section 5.4.1 of the revised manuscript. 
 

“6. Lines 157-163, 188-208, etc.: The Protocol should contain only action items that direct the reader to do 
something. Please write the text in the imperative tense and move the discussion about the protocol to the 
Discussion.” 

Done. 
 

“7. Lines 214-280: Software must have a GUI (graphical user interface) and software steps must be more 
explicitly explained ('click', 'select', etc.). Please add more specific details (e.g. button clicks for software 
actions, numerical values for settings, etc.) to your protocol steps.” 

We have provided further details in this regard wherever appropriate in the protocol of the revised 
manuscript. 
 

“8. Please include single-line spaces between all paragraphs, headings, steps, etc.” 
Done. 

 
“9. After you have made all the recommended changes to your protocol (listed above), please highlight 
2.75 pages or less of the Protocol (including headings and spacing) that identifies the essential steps of the 
protocol for the video, i.e., the steps that should be visualized to tell the most cohesive story of the 
Protocol.” 

Done. 
 
“10. Please highlight complete sentences (not parts of sentences). Please ensure that the highlighted part 
of the step includes at least one action that is written in imperative tense.” 

Done. 
 
“11. Please include all relevant details that are required to perform the step in the highlighting. For 
example: If step 2.5 is highlighted for filming and the details of how to perform the step are given in steps 
2.5.1 and 2.5.2, then the sub-steps where the details are provided must be highlighted.” 

Done. 
 
“12. JoVE article does not have a Conclusion section. Please move information in the Conclusion section to 
Results or Discussion section.” 

This portion was eliminated, to reduce redundancy. 
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REVIEWER #1 comments and Author responses: 
 “Manuscript Summary: 
This manuscript presents a protocol for the evaluation of vascular flows in vitro. The protocol description 
comprises 3 major blocks: (1+2) Fabrication of the phantom, (3) preparation of the working fluid, (4) Video 
recording, and (5) Particle Image Velocimetry (PIV) analysis. 
The part of mold fabrication (1+2) is interesting and provides numerous practical insights and advices, the 
preparation of the working fluid and recording (3+4) is more standard but can be useful. The PIV analysis 
(5) is less accurate and includes arbitrary subjective choices.” 
 
“Major Concerns: 
My major concern is that the protocol describes in depth some steps of a more complete procedure, where 
some parts are not mentioned, some are faced very superficially while some others are analyzed in depth. 
I think that this structure can be misleading. 
In summary, I advise to limit the protocol to phantom fabrication (1+2) with indication of image recording 
(3+4). Possibly mentioning how this fits into a complete in-vitro modelling of vascular systems (which 
include, at least, imaging/design, circulation system).” 
 
“Below are my detailed comments:” 
 
“1) The part of PIV analysis combines pre-filtering of images, regular PIV calculation (performed by an 
external package) and post-filtering/validation of the results. I find this part very superficial and not useful. 
There are numerous PIV packages available (that include pre/post filtering) whose optimization depends 
on numerous details, including image properties and calculation objectives, that cannot be covered here. 
Therefore, I suggest to remove this part and simply refer to a general PIV processing. Otherwise, if authors 
want to keep this part, I suggest that they present it as made of 3 sub-phases. One is pre-filtering (5.1, 
where they clarify that and their choices are possible proposal -not necessarily the optimal- among 
numerous others). A second is PIV calculation (where cross-correlation is one option, while there are others 
that more now common because better performing). The third is validation or filtering of results (NMT is 
one option -not necessarily the optimal- among many others).” 

The image analysis section of the Protocol has been reformatted as suggested in the revised 
manuscript. In the Discussion section, we have also clarified that each of the methods described 
represents just one of several potential options. While we agree that other techniques may achieve 
higher performance (e.g., least-squares matching, hybrid PIV/PTV), this level of sophistication was 
deemed unnecessary for determining first-order approximations of the characteristics of current 
interest (i.e., intra-aneurysmal velocity fields). However, since other researchers may be interested 
in characteristics that are more sensitive to velocity field resolution (e.g., wall shear stress or 
vorticity), we have added further discussion in this regard, as well as citations to more authoritative 
work in this area. 
 

“2) The part of preparation of the geometry for the vessel is completely missing. It comprises its design 
within CAD that can be based on images (which type, how recorded...?) or based on 
combination/deformation of simple geometric models. This preliminary phase (which would be before 
phase 1) is not reported or mentioned.” 

We have clarified in the Introduction of the revised manuscript that the fabricated phantom 
geometries are based upon idealized representations of neurovascular structures (which are 
generated using a common CAD software package). We have also clarified that  fabrication of more 
complex, patient-specific geometries should be possible as well (e.g., via use of model files 
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generated by conversion of clinical imaging data into the .STL file format used by most 3D printers). 
However, we believe that further elaboration in this regard lies beyond the scope of the current 
protocol.  
 

“3) Similarly to the previous point, the in-vitro circulatory system is not described. This challenging 
experimental aspect is not mentioned here.” 

We have provided further details in this regard in Sections 4 and 5.2 of the revised manuscript. 
 

“Minor Concerns:” 
“4) p.1 l.79. Specify the cost >$100k, or eliminate explicit figure. Because it looks a lot, if you do not consider 
the laser that can be easily substituted by simpler illumination systems.” 

It’s been our experience that the base cost of commercial turn-key 2D PIV systems often runs well 
beyond $100k (not including fluorescence microscope or other ancillary equipment), hence the 
inclusion of this figure in the original manuscript. However, we acknowledge that there may be 
potential for significant variation in system configuration depending on specific users’ needs, so we 
have eliminated this figure in the Introduction of the revised manuscript. 

 
“5) The protocol is limited to steady-state conditions, which represents an important limitation for vascular 
vessels of pathological interest. This limitation does not appear necessary to the protocol (image recording 
is made with high frame rate and the experimental circulatory system is not described). Please clarify.” 

Synchronization of the video to the desired temporal positions in the waveform would be required, 
which would increase setup cost and complexity. Since steady-state conditions have been sufficient 
for the needs of our application thus far, we have not explored these avenues further. 

 
 
Reviewer #2 comments and Author responses: 
“Manuscript Summary: The authors report a method to perform PIV measurements in mm-scale phantoms 
of the human vascular system, claiming this to be a cheap(er) option. 
 
Major Concerns: the authors claim to have a cheap way to circumvent several tools that are needed for 
PIV measurements. However, when using a continuous laser source (instead of pulsed) there is no need to 
sync the laser and the camera, this is already available in classical textbooks about PIV. Furthermore the 
authors do not elaborate about the light source they are using in the reported method. I think the authors 
should remove this claim, as the needed components are still costly (3D printer, high speed camera, 
microscope, light source, ultrasonic cleaner etc.)” 

The specifics of the light source were detailed in the Table of Materials document of the original 
manuscript (i.e., external metal halide continuous white light source for through-objective, 
volumetric illumination). However, the Reviewer’s comment suggests that it would’ve been better 
to also include this information within the manuscript body itself. As such, we have remedied this 
omission in the Introduction of the revised manuscript. 
 
The intent of the protocol is not to demonstrate the most inexpensive PIV system possible, but 
rather to demonstrate a means for implementing PIV using resources already at the disposal of 
many bioengineering researchers. In doing so, this reduces the need for acquisition of some of the 
more costly components of a typical PIV system, thus lowering the barrier to entry for non-experts. 
We have clarified this point throughout the revised manuscript. 
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“Minor Concerns:” 
 
“page 2, line 114, the use of acetone fumes (which is mentioned in the discussion) is a very good addition 
to the protocol, we do this in our lab for all flow phantoms we make to ensure a smooth surface, and also 
seal the print, to prevent air that resides in the phantom from entering the PDMS. Furthermore, report 
about the thickness of your print, and refer to printing hollow to have a good circulation of the acetone to 
promote dissolving the ABS. The container you pour the PDMS into should have nice flat and smooth 
surfaces to prevent reflection of the light source.” 

We have clarified in the Introduction of the revised manuscript that our models are based on solid 
prints, since this best ensures mold integrity, particularly for our most diminutive features. 
However, we have also added brief discussion of the virtues of hollow models as well.  
 
While we acknowledge the potential advantages of acetone smoothing, our experience thus far has 
not shown the necessity for this operation, hence its omission from the current protocol. 

 
“page 2, line 127, you can also cure in a stove to speed up the process (be done in 1 or 2 hours).” 

We have provided further details in this regard in Section 2.2.3 of the revised manuscript. 
 
“page 3, line 142, only water and glycerol will not match the refractive index with PDMS (unless you add 
a lot of glycerol, making the viscosity very unrealistic), you should introduce a salt, like Sodium iodide, to 
truly match the refractive index” 

As discussed in the original manuscript, the 60:40 DI/glycerol mock blood solution is used widely in 
the experimental hemodynamics community, and the references cited make no mention of salt. 
This therefore suggests that perfect index matching may not be a necessity for applications such as 
those considered here (i.e., neurovascular flows). We have added further citations in this regard in 
the revised manuscript, including: 
 
- Bouillot, P., Brina, O., Ouared, R., Lovblad, K.-O., Farhat, M., Pereira, V.M. Particle Imaging 

Velocimetry Evaluation of Intracranial Stents in Sidewall Aneurysm: Hemodynamic Transition 
Related to the Stent Design. PLoS ONE. 9 (12), e113762, doi: 10.1371/journal.pone.0113762 
(2014). 

- Trager, A.L., Sadasivan, C., Lieber, B.B. Comparison of the in vitro hemodynamic performance 
of new flow diverters for bypass of brain aneurysms. Journal of biomechanical engineering. 134 
(8), 084505, doi: 10.1115/1.4006454 (2012). 

 
“page, 4, line 177, elaborate about the used light source, no sheet? What about out of plane motion?” 

As discussed earlier, the specifics of the light source were detailed in the Table of Materials 
document of the original manuscript (i.e., external metal halide continuous white light source for 
through-objective, volumetric illumination), and this information has now been added in the 
Introduction of the revised manuscript. 
 
Volumetric illumination is chosen in the current protocol to simplify implementation. It is also 
commonly used in micro-PIV, since the depth of focus approaches the thickness of typical light 
sheets. Since the depth of focus is small at higher magnifications, out of plane motions that are 
large relative to the focal depth will result in potential correlation error due to mismatching, similar 
to that which would be seen for a light sheet. Smaller out of plane motions will contribute to cosine-
error, as is also commonly encountered with light sheets. 
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“page 4, line 216, other tools like Pivlab, built in the Matlab environment is a good and versatile tool” 

ImageJ was chosen for ease of implementation, as well as its broad familiarity to the bioengineering 
community. 

 
“page 6, line 295, these images lack a reference, were in the phantom are these images taken? what is the 
scale? add vessel walls as a reference. How did you mask the images?” 

The location of the images presented in Figs. 3 and 4 was detailed in the Representative Results 
section in the original manuscript (i.e., within the perforator artery). However, the Reviewer’s 
comment suggests that it would’ve been better to also include this information within the captions 
as well. We have remedied this omission in the revised manuscript. Scale bars have also been added 
to these figures, as have dotted lines to demarcate the vessel walls. Finally, the location of the ROI 
for these measurements has been added to Figure 2. 
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meso-scale regime (i.e., sub-mm to mm length-scales). Herein, we present a simplified 45 
experimental protocol developed to address these limitations, the key elements of which include: 46 
1) a relatively low-cost method for fabricating meso-scale tissue phantoms using 3D printing and 47 
silicone casting; and 2) an open-source image analysis and processing framework that reduces 48 
demand upon the instrumentation for measuring meso-scale flows (i.e., velocities up to tens of 49 
mm/s). Collectively, this lowers the barrier to entry for non-experts by leveraging resources 50 
already at the disposal of many bioengineering researchers. We demonstrate the applicability of 51 
this protocol within the context of neurovascular flow characterization; however, it is expected 52 
to be relevant to a broader range of meso-scale applications in bioengineering and beyond. 53 
 54 
INTRODUCTION:  55 
Particle image velocimetry (PIV) is widely used in experimental fluid mechanics for flow 56 
visualization and quantitative investigations of fluid motion that vary in length-scale from 57 
atmospheric to microcirculatory flows1–3. While the specifics of its implementation can vary as 58 
widely as its applications, one aspect common to nearly all PIV studies is the use of video imaging 59 
of tracer particles seeded within the working fluid, followed by pair-wise analysis of consecutive 60 
image frames to extract desired flow characteristics. Typically, this is accomplished by first sub-61 
dividing each image frame into smaller regions termed interrogation windows. As a consequence 62 
of the random positions of the dispersed particles, each interrogation window contains a unique 63 
distribution of pixel intensities. If the window size and data acquisition rate are chosen 64 
appropriately, cross-correlation of the intensity signal in each window can be used to estimate 65 
the average displacement within that region. Finally, given that the magnification and frame rate 66 
are known experimental parameters, an instantaneous velocity vector field can be readily 67 
computed.  68 
 69 
A major advantage of PIV over single-point measurement techniques is its ability to map vector 70 
fields across a two- or three-dimensional domain. Hemodynamic applications, in particular, have 71 
benefited from this capability, since it allows a thorough investigation of local flows, which are 72 
known to play a significant role in vascular disease or remodeling (e.g., atherosclerosis, 73 
angiogenesis)4–6. This has also been true for the evaluation of neurovascular flows, and the 74 
interactions thereof with endovascular devices (e.g., flow diverters, stents, intra-saccular coils, 75 
etc.), since the relevant lengths-scales in such applications can often span one or more orders of 76 
magnitude (e.g., micrometer to mm-scale), and device geometry and placement can significantly 77 
impact the local fluid mechanics7.   78 
 79 
Most groups conducting PIV-based hemodynamics studies have relied on experimental setups 80 
that closely mimic some of the earliest investigations of stent influence on vascular flow7, 8. 81 
Typically, these include: a) pulsed lasers and high-speed cameras, to capture high velocity flows; 82 
b) synchronizers, to prevent aliasing between the pulse frequency of the laser and the camera 83 
acquisition frame rate; c) cylindrical optics, to form a light sheet, and thus, minimize background 84 
fluorescence from tracer particles above and below the interrogation plane; and d) in the case of 85 
commercial turn-key systems, proprietary software packages, to perform the cross-correlation 86 
analyses. However, while some applications require the performance and/or versatility 87 
collectively afforded by these components, many others do not. Moreover, the high cost of 88 



   

Page 2 of 13  revised November 2017 
 

commercially-sourced tissue phantoms that recapitulate desired vascular structures can also 89 
prove limiting for many in vitro studies, particularly for phantoms with features that bridge the 90 
meso-scale regime (> $500/phantom). Herein, we report the development of a simplified 91 
protocol for implementing PIV for in vitro visualization of neurovascular flows, which typically lie 92 
both spatially and temporally within the meso-scale regime (i.e., length-scales ranging from sub-93 
mm to mm, and velocities up to tens of mm/s). The protocol seeks to leverage resources already 94 
at the disposal of many bioengineering researchers, thus lowering the barrier to entry for non-95 
experts. 96 
 97 
The first element of this protocol involves the use of an investment casting technique to enable 98 
in-house fabrication of transparent, polydimethylsiloxane (PDMS)-based tissue phantoms from 99 
3D-printed sacrificial molds. By leveraging the increasing availability of 3D printers in recent 100 
years, particularly those in shared/multi-user facilities (e.g., institutional facilities or public 101 
makerspaces), this methodology cuts cost significantly (e.g., < $100/phantom in our case), while 102 
enabling rapid turnaround for fabrication of a wide variety of designs and geometries. In the 103 
current protocol, a fused deposition modeling system is used with acrylonitrile butadiene styrene 104 
(ABS) as the build material, and the printed part serves as a sacrificial mold for the subsequent 105 
phantom casting. Our experience has shown that ABS is well-suited for such use, since it is soluble 106 
in common solvents (e.g., acetone), and it has sufficient strength and rigidity to maintain mold 107 
integrity after removal of the support material (e.g., to prevent deformation or fracture of 108 
diminutive mold features). In the current protocol, mold integrity is further ensured through the 109 
use of solid printed models, although this comes at the expense of increased dissolution time. 110 
Use of hollow models may also possible in some cases, to enhance solvent access, and thus, 111 
reduce dissolution time. However, careful consideration should be given to the effect this may 112 
have on mold integrity. Finally, while the phantoms fabricated herein are based upon idealized 113 
representations of neurovascular structures generated using a common CAD software package, 114 
the protocol is expected to be amenable to the fabrication of more complex, patient-specific 115 
geometries as well (e.g., via use of model files generated by conversion of clinical imaging data 116 
into the .STL file format used by most 3D printers). Further details regarding the phantom 117 
fabrication process are provided in Section 2 of the Protocol. 118 
 119 
The second element of the protocol involves the use of an open-source plug-in for ImageJ to 120 
conduct the cross-correlation analyses9. This is coupled with the implementation of a simple 121 
statistical thresholding scheme (i.e. intensity capping)10 to improve image signal prior to cross-122 
correlation, as well as a post-correlation vector validation scheme, the normalized median test 123 
(NMT), to eliminate spurious vectors through comparison of each to its nearest neighbors11. 124 
Collectively, this allows imaging to be accomplished using equipment commonly found in many 125 
bioengineering laboratories, thus eliminating the need for acquisition of many of the costly 126 
components of typical PIV systems (e.g., pulsed laser, synchronizer, cylindrical optics, and 127 
proprietary software). Further details regarding the video collection, image processing, and data 128 
analysis are provided in Sections 5 and 6 of the Protocol. 129 
 130 
Figure 1 illustrates the PIV setup used in this protocol, which relies upon a fluorescence 131 
microscope equipped with a high-speed camera for imaging, as well as an external, continuous 132 
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white-light source (i.e., metal halide lamp) for through-objective volumetric illumination. A 133 
variable-speed gear pump is used to impose recirculating flow of a transparent mock blood 134 
solution through the neurovascular tissue phantoms. The solution is composed of a 60:40 135 
mixture of DI water and glycerol, which is a common substitute for blood in hemodynamics 136 
studies12–14,  due to: a) its similar density and viscosity, i.e. 1080 kg/m3 & 3.5 cP, vs. 1050 kg/m3 137 
& 3.0 – 5.0 cP for blood15, 16; b) its transparency in the visible range; c) its similar refractive index 138 
as PDMS (1.38 vs. 1.42 for PDMS)17–20 , which minimizes optical distortion; and d) the ease with 139 
which non-Newtonian behavior can be introduced, if needed, via the addition of xanthane21. 140 
Finally, fluorescent polystyrene beads are used as tracer particles (10.3 μm diameter; 480 141 
nm/501 nm excitation/emission). While neutrally-buoyant beads are desired, sourcing tracer 142 
particles with optimal fluid mechanical properties (e.g., density, size, composition) and emission 143 
wavelength can prove challenging. For example, the beads used herein are slightly less dense 144 
than the glycerol solution (1050 kg/m3 vs. 1080 kg/m3). However, the hydrodynamic effects 145 
thereof are negligible, given that the duration of a typical experiment is far shorter than the time 146 
scale associated with buoyancy effects (i.e., 5 min & 20 min, respectively). Further details 147 
regarding the mock blood solution formulation and in vitro circulatory system setup are provided 148 
in Sections 3 and 4 of the Protocol.  149 
 150 
PROTOCOL:  151 
1. ABS-BASED SACRIFICIAL MOLD FABRICATION 152 

1.1. Design an inverse model of the desired tissue phantom using CAD software. 153 
1.2. Print the model using a 3D printer with ABS as the build material. 154 

2. PDMS-BASED VASCULAR PHANTOM FABRICATION 155 
2.1. Mixing 156 

2.1.1. Mix the PDMS prepolymer base and curing agent in a 10:1 ratio (by weight). A 66 g 157 
mixture provides sufficient material for fabrication of phantoms with volumes up to 158 
50 cm3. 159 

2.1.2. Place the mixture in a vacuum desiccator for 60 min to degas and minimize bubble 160 
entrapment. Use cyclic pressurization/depressurization to facilitate bubble rupture.  161 

2.2. Casting  162 
2.2.1. Mount the printed ABS mold on a glass slide using molding putty to seal the 163 

interface. 164 
2.2.2. Carefully pour the PDMS mixture into the mold while trying to minimize bubble 165 

entrapment. Lingering bubbles can be manually ruptured using a needle. 166 

2.2.3. Cure the cast phantom at room temperature (25C) for at least 24 h. At higher 167 
temperatures this process can be accelerated22.  168 

2.3. Demolding 169 
2.3.1. Dissolve the ABS by submerging the phantom in acetone and sonicating for at least 170 

15 min using powers up to 70 W.  171 
 172 

CAUTION: Acetone has high vapor pressure at room temperature and low flash point. 173 
Consequently, always work under a fume hood and away from potential ignition 174 
sources. Wear proper personal protective equipment (e.g., goggles or face shield, lab 175 
coat, acetone-resistant gloves, etc.). 176 
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 177 
2.3.2. Thoroughly rinse the phantom with isopropyl alcohol, and then DI water to remove 178 

solvent residues. 179 
 180 

NOTE: PDMS swells upon exposure to acetone; however, swelling subsides once the 181 
phantom is rinsed and dried sufficiently23. 182 

 183 
2.4. Confirm phantom fidelity using optical microscopy 184 

2.4.1. Using an optical microscope with attached camera and image capture software, 185 
capture an image of a critical feature within the phantom under a magnification that 186 
maximizes the feature within the field of view. 187 

2.4.2. Capture an image of an appropriate calibration reticle at the same magnification. 188 
2.4.3. Load both images into ImageJ by dragging them onto the “Toolbar”. 189 
2.4.4. Click on the calibration reticle image to make it active, and then select the “Line” 190 

tool. Using the mouse, draw a line along a feature of a known distance and select 191 
“Analyze” > “Set Scale…” from the ImageJ menu.  192 

2.4.5. In the “Set Scale” window, the field labeled “Distance in pixels” should be pre-193 
populated with the length of the drawn line in units of pixels. Enter the length of the 194 
feature in the field labeled “Known Distance”, and its units in the field labeled “Unit 195 
of Length”. Check the box labeled “Global” to apply this calibration factor to all open 196 
images. 197 

2.4.6. Make the image of the phantom critical feature active and use the “Line” tool to 198 
draw a line along a feature of interest. 199 

2.4.7. From the ImageJ menu, select “Analyze” > “Measure” (or press Ctrl + M) to measure 200 
the length of the line. 201 

2.4.8. Compare the expected value against the value in the column marked “Length” in 202 
the “Results” window to confirm phantom fidelity. 203 

3. MOCK BLOOD SOLUTION FORMULATION 204 
3.1. Mix DI water and glycerol in a 60:40 ratio (by volume). A 100 mL volume is sufficient for 205 

the in vitro circulatory system described herein. 206 
3.2. Add 1 mL of 2.5% w/v fluorescent polystyrene bead solution (i.e., tracer particles) to the 207 

mock blood solution.   208 
3.3.  Homogenize the mixture on a magnetic stir plate at 400 rpm for 10 min.  209 

4. IN VITRO CIRCULATORY SYSTEM SETUP 210 
4.1. Pump Setup 211 

4.1.1. Use a wire stripper tool to cut off the DC-end plug from the AC to DC adapter power 212 
source.  213 

4.1.2. Strip the coating off the power and ground wires and connect them to the input 214 
terminal of the pulse width modulation (PWM) voltage regulator.  215 

4.1.3. Connect the power and ground wires from the pump’s DC motor to the output 216 
terminal of the PWM voltage regulator. The PWM’s 7-segment display outputs the 217 
duty cycle (0% - 100%) used to achieve a variable voltage to the DC motor.  218 

4.2. Pump Calibration 219 
4.2.1. Prepare 200 mL of mock blood solution (see Section 3).  220 
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4.2.2. Place tubing from the pump inlet to the beaker holding the mock blood solution. 221 
4.2.3. Place tubing from the pump outlet to an empty beaker. 222 
4.2.4. Select a desired duty cycle set-point (0% - 100%). Press the “On” button and start a 223 

timer.  224 
4.2.5. Stop the timer once the pump has transferred the entire volume of mock blood 225 

solution. Use this time to calculate the volumetric flow rate. 226 
4.2.6. Repeat steps 4.2.1 – 4.2.5 for at least 5 different duty cycle set-points to establish 227 

a least-squares regression curve. A minimum of three replicate points per duty cycle 228 
set-point is recommended. This relationship can be used to correlate the desired flow 229 
rate to the required PWM duty cycle.  230 

5. VIDEO COLLECTION 231 
5.1. Image calibration 232 

5.1.1. Determine calibration ratio for the video imaging (see Section 2). 233 
5.2. Apparatus set up 234 

5.2.1. Place the PDMS phantom on the stage of the fluorescence microscope. 235 
5.2.2. Connect the phantom to the gear pump and introduce the mock blood solution. 236 

 237 
 (Optional) Pre-fill the model with ethanol to facilitate full wetting, then flush and fill 238 
with mock blood solution. This may be particularly beneficial for models with smaller 239 
vessels and/or blind features.  240 
  241 

5.2.3. Set the pump motor controller for the desired flow rate based on the pump 242 
calibration curve. 243 

5.2.4. Run the pump for 1 - 5 min prior to the experiment to ensure steady-state 244 
conditions. 245 

5.2.5. Turn on the external lamp to illuminate the field of view. Select an appropriate filter 246 
based upon the excitation wavelength of the fluorescent beads. 247 

5.2.6. Adjust the imaging focal plane to the vessel mid-plane. This can be achieved by 248 
using a focal length that maximizes the imaged vessel cross-section (e.g., when using 249 
phantoms with circular vessel cross sections); and/or indexing off of a phantom 250 
feature designed to facilitate identification of the vessel mid-plane. 251 

5.3. Video recording 252 
5.3.1. Select the video recording parameters to optimize signal-to-noise ratio (SNR). Key 253 

parameters include exposure time, frame rate, and gain. In this protocol we use a 254 
frame rate of 2000 fps, and a gain of 1.0. However, these parameters may vary based 255 
on application (see Discussion section for further details).  256 

5.3.2. Collect video and save in AVI format. 257 
5.4. Phantom clean up 258 

5.4.1. If bead-sticking is observed after an experiment, sonicate the phantom in an 259 
aqueous detergent solution using powers up to 70 W.  260 

6. IMAGE PROCESSING AND DATA ANALYSIS 261 
6.1. Image pre-processing 262 

6.1.1. Drag the saved AVI file onto the ImageJ window to import it. Select the box marked 263 
“Convert to Grayscale”. 264 
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6.1.2. From the “ImageJ” menu, select “Analyze” > “Generate Histogram” (or press Ctrl + 265 
H) to generate a histogram of image pixel intensities. Take note of the mean and 266 
standard deviation for the unprocessed image. 267 
 268 

NOTE: At high frame rates, it is not unusual for the distribution to be skewed 269 
heavily toward zero (i.e., no signal). 270 

 271 
6.1.3. From the “ImageJ” menu, select “Image” > “Adjust”> “Brightness and Contrast” (or 272 

press Shift + Ctrl + H) to apply a brightness/contrast filter.  273 
6.1.4. On the “Brightness and Contrast” menu, press the “Set” button to define the image 274 

limits. Set the minimum value to be the mean value plus one standard deviation, and 275 
the maximum value to be the maximum intensity of the image (both based on 276 
statistics obtained in Section 6.1.2).  277 
 278 

NOTE: This typically eliminates all but the top 10% of pixel intensities. The number 279 
of standard deviations may be varied depending on the desired distribution of 280 
pixel intensities. A custom macro script for performing the intensity capping 281 
operation is provided in the Supplemental Material. 282 

 283 
6.1.5. From the “ImageJ” menu, select “Process” > “Noise” > “Despeckle” to reduce the 284 

number of saturated pixels. 285 
 286 

NOTE: This operation is necessitated by the increased potential for pixel saturation 287 
that arises during optimization of brightness and contrast, which can produce 288 
spurious vectors during subsequent cross-correlation. 289 

 290 
6.1.6. From the “ImageJ” menu, select “Process” > “Filters” > “Gaussian Blur” with a 291 

radius of 1.5 to reduce artifacts arising from the occasional removal of illuminated 292 
pixels in a 3x3 neighborhood by the prior despeckling operation. 293 

6.1.7. Click on the “Polygon” tool, and then click within the image to outline the region of 294 
interest (ROI).  295 

6.1.8. From the “ImageJ” menu, select “Edit” > “Clear Outside” to remove sensor noise in 296 
locations where no signal is expected (e.g., areas beyond vessel wall boundary), which 297 
can decrease overall SNR. 298 

6.2. PIV Calculation 299 
 300 
NOTE: This portion of the protocol employs a third-party PIV plug-in for ImageJ, which 301 
relies upon Gaussian peak-fitting to enable estimation of displacement with sub-pixel 302 
accuracy. 303 
 304 

6.2.1. From the “ImageJ” menu, select “Plugins” > “Macros” > “Run…” and navigate to the 305 
saved macro “Supplemental Code 2.ijjm” to cross-correlate successive image pairs.  306 
 307 

NOTE: The macro proceeds as follows:1) Cross-correlation of the intensity field 308 
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within consecutive images is first performed to determine the local displacement 309 
of advected tracer particles, i.e. the first image pair consists of the first and second 310 
images, the second image pair consists of the second and third images, etc.; 2) a 311 
two-step multi-pass evaluation is then performed with initial and final 312 
interrogation window sizes of 256 x 256 pixels and 128 x 128 pixels, respectively; 313 
and finally, 3) the macro performs a temporal average to further reduce the 314 
appearance of spurious vectors. 315 
 316 

6.3. Normalized median test (NMT) 317 
6.3.1. From the “ImageJ” menu, select “Plugins” > “Macros” > “Run…” and navigate to the 318 

saved macro “Supplemental Code 3.ijjm” to validate the velocity fields via the 319 
normalized median test.  320 
 321 

NOTE: The macro proceeds as follows: 1) each vector in an instantaneous vector 322 
field is first compared to its eight nearest neighbors to compute the median value; 323 
2) the array of residual errors is then calculated as the difference between each 324 
neighboring vector and the calculated median; 3) the difference between the 325 
vector under investigation and the median neighboring vector value is then 326 
normalized by the median of the residuals; 4) this is then compared to a threshold 327 
value (typically 0.2 pixels), which can be varied based on a priori knowledge of 328 
noise during image acquisition; and finally, 5) a temporal average of all validated 329 
instantaneous vector fields is performed to produce a composite field, as this has 330 
been shown to increase the vector field quality24. 331 

 332 
REPRESENTATIVE RESULTS:   333 
Figure 2 illustrates the PDMS tissue phantom fabrication process. The phantoms designed herein 334 
are intended for the study of flow in idealized wide-necked, saccular, intracranial aneurysms, as 335 
well as proximal branching perforator arteries. Important additional design features include: 1) a 336 
common reservoir that all vessels drain into, to ensure unencumbered fluid egress from the 337 
phantom, otherwise droplet formation may occur at the smaller vessel outlets; 2) a bubble trap, 338 
to facilitate bubble removal; 3) an outer cavity wall, to ensure parallelism of the vessel with the 339 
horizontal plane, as well as precise definition of the final phantom slab height, length and width; 340 
and 4) use of a 21 gauge hypodermic needle shank (820 µm nominal outer diameter) for molding 341 
of the perforator artery, due to our printer’s inability to define such features with sufficient 342 
fidelity. Faithful reproduction of all design features is observed throughout. 343 
 344 
Representative results for PIV-based flow characterization performed using the current protocol 345 
are presented in Figures 3 and 4. These studies were performed using phantom inlet flow rates 346 
of 100 mL/min, data acquisition rates of 2000 fps, and temporal averaging over spans of 0.05 s. 347 
Figure 3 shows representative image frames within the perforator artery, before and after 348 
intensity capping as well as corresponding surface plots of the 8-bit pixel intensity values. Both 349 
demonstrate that intensity capping significantly increases peak definition above the noise floor 350 
(i.e., increases SNR), which is critical to ensuring accuracy when performing subsequent cross-351 
correlation. Figure 4 shows the effects of intensity capping and NMT operations on the velocity 352 
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vector field. Marked improvement in field uniformity is observed, thus further underscoring the 353 
importance of maximizing SNR to minimize data dropout.  354 
 355 
FIGURE AND TABLE LEGENDS:  356 
 357 
Figure 1: Particle image velocimetry setup. Reliance upon an open-source image analysis and 358 
pre/post-processing framework reduces demand upon the instrumentation for measuring meso-359 
scale flows, thus eliminating the need for many of the costly components of typical PIV systems 360 
(e.g., pulsed laser, synchronizer, cylindrical optics, &/or proprietary software). 361 
  362 
Figure 2: PDMS-based tissue phantom fabrication process: a) CAD model of neurovascular 363 
phantom mold; b) Printed ABS mold, after removal of support material; c) Casting and curing of 364 
PDMS within the ABS mold; d) Partial dissolution of ABS mold material; and e) Completed PDMS 365 
phantom, with inset showing final dimensions of critical features, as well as the region of interest 366 
(ROI) in the perforator artery where the PIV measurements were made.   367 
 368 
Figure 3: Effect of intensity capping operation on image SNR. Representative image frame and 369 
corresponding pixel intensity surface plots within the perforator artery, before (a, b) and after 370 
applying the intensity capping operation (c, d). 371 
 372 
Figure 4: Effects of intensity capping and NMT operations on velocity vector fields: 373 
Representative instantaneous velocity vector field within the perforator artery derived from: a) 374 
unprocessed image data; b) intensity capped data; and c) intensity capped data + NMT post-375 
processing.  376 
 377 
Figure 5: Effect of interrogation window sizing on correlation quality. Optimal window sizing 378 
occurs when the value of the zero-normalized correlation coefficient is maximized, and the 379 
standard deviation is minimized. 380 
 381 
DISCUSSION:  382 
The protocol described herein outlines a simplified method for performing PIV studies to visualize 383 
neurovascular flows at physiologically-relevant dimensions and flow conditions in vitro. In doing 384 
so, it serves to complement protocols reported by others that have also focused on simplifying 385 
the quantification of vector fields, but within very different contexts that require consideration 386 
of far larger length-scales25 or lower flow rates26, 27(e.g. atmospheric or microcirculatory flows), 387 
and thus, reliance upon schemes that are incompatible with the current application.  388 
 389 
The most important considerations for successful implementation of PIV lie in the minimization 390 
of flow field artifacts and maximization of image quality. Several steps in the tissue phantom 391 
fabrication process are critical to both of these criteria. For example, thorough degassing is crucial 392 
since air entrained within the PDMS during mixing can lead to bubble formation within the final 393 
phantom, which can adversely affect both feature fidelity and optical clarity. Additionally, 394 
minimization of surface roughness of the ABS mold is desired, since the PDMS casting process 395 
faithfully reproduces even the most minute imperfections (e.g., build lines, surface pores, 396 
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scratches, etc.), thus resulting in surface roughness in the final phantom that can decrease optical 397 
clarity and increase potential for bead accumulation. While the protocol described herein has 398 
proven sufficient for the current application, there are numerous reports in the literature of 399 
means for reducing such roughness, should there be need (e.g., acetone vapor smoothing28, or 400 
optimization of layer thickness and part orientation with respect to build direction)29. 401 
 402 
Parameter selection for video capture is also critical to ensure a high-fidelity vector field. Optimal 403 
SNR is typically achieved at the highest achievable frame rate that still allows sufficient bead 404 
exposure (maximum frame rate being limited by minimum exposure time). Gain can be used to 405 
amplify the signal, but this also increases sensor noise. If the maximum velocity can be estimated 406 
from other flow parameters (e.g., inlet volumetric flow rate), then a lower bound on the required 407 
frame rate can be estimated using the following relation30: 408 

 409 

𝑓𝑠𝑎𝑚𝑝𝑙𝑖𝑛𝑔 >
𝑣𝑚𝑎𝑥∙𝑐𝑐𝑎𝑙𝑖𝑏𝑟𝑎𝑡𝑖𝑜𝑛

ℎ𝑖𝑛𝑡𝑒𝑟𝑟𝑜𝑔𝑎𝑡𝑖𝑜𝑛 𝑤𝑖𝑛𝑑𝑜𝑤
 (1) 410 

 411 
where fsampling is the camera acquisition rate (Hz), vmax is the maximum expected velocity (mm/s), 412 
ccalibration is the calibration constant (pixels/mm), and hinterrogation window is the size of the 413 
interrogation window (pixels). However, more optimal values can be determined using so-called 414 
correlation quality estimation techniques, such as the zero-normalized correlation coefficient11. 415 
In this technique, the averages of complementary signals from each frame-pair are first 416 
subtracted, and then normalized by the standard deviation of their intensities11. If a displacement 417 
of the original signal exists, such that all peaks and valleys match, the time-shifted value of this 418 
signal will be equal to one. Conversely, if there is no displacement that can align these signals, 419 
the value will be zero. This information is included in the ImageJ PIV output for each vector, and 420 
it can be plotted as its own field to verify whether there are spatial effects contributing to poor 421 
correlation (e.g., uneven lighting). The correlation coefficient can also be averaged over a field as 422 
an overall estimate of its quality. Finally, this quantity may also be plotted against varying frame 423 
rates or interrogation window sizes to determine an optimum. Figure 5 illustrates the results 424 
from such an analysis using a Monte-Carlo synthesized particle field with displacements 425 
consistent with our experimentally-measured flows (a typical technique for characterizing 426 
correlation quality11). The results show that the interrogation window size and frame rate should 427 
be chosen such that a particle field is displaced by ≤ 20% of the interrogation window size per 428 
frame-pair to maximize the correlation coefficient, while minimizing its variability.  429 
 430 
Although the protocol described herein has proven sufficient for meeting the needs of the 431 
current application, it is important to acknowledge its limitations. For example, while contrast 432 
enhancement via intensity capping offers ease of implementation, transformations of the entire 433 
distribution of pixel intensities may improve SNR further31. Similarly, although correlation-based 434 
tracking is well-established and provides sufficient resolution for reliably estimating first-order 435 
flow characteristics relevant to hemodynamics (e.g., intra-aneurysmal velocity), other techniques 436 
may offer higher spatial resolution (e.g., hybrid PIV/PTV, least squares matching)32, 33, and thus 437 
greater accuracy when considering characteristics that are more sensitive to velocity field 438 
resolution (e.g., wall shear stress, in-plane vorticity). Likewise, while the NMT provides a means 439 
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for improving the velocity vector field after cross-correlation, it is important to emphasize that 440 
this is just one of many vector validation techniques that could be used24, 34, each with their own 441 
unique advantages and disadvantages that may make their use more suitable for applications 442 
beyond those described here. Lastly, while our experimental setup seeks to mimic 443 
physiologically-relevant flow rates and length scales for the neurovasculature, it does not 444 
currently allow the analysis of pulsatile flows. This has not been a limitation for our current 445 
application, since the range of Womersely numbers in much of the neurovasculature tends to be 446 
≤ 1 (i.e., there is minimal additive effect of multiple cardiac cycles)35, which suggests that steady-447 
state conditions are sufficient to recapitulate discrete time points along the cardiac waveform in 448 
which the flow rate is comparable. However, for applications where the Womersely number is 449 
larger (e.g., vasculature closer to the heart), we envision potential for introducing pulsatility 450 
through the use of an Arduino, which could be used to send the pump a time-varying PWM 451 
voltage waveform that enables mimicking of a cardiac flow profile36–38. 452 
 453 
ACKNOWLEDGMENTS:   454 
The authors acknowledge partial support for this project provided by a Collaborative Seed Grant 455 
from the Office of Research and Economic Development at UC Riverside. 456 
 457 
DISCLOSURES:   458 
The authors declare no competing financial interests. 459 
 460 
REFERENCES  461 
1. Grant, I. Particle image velocimetry: A review. Proceedings of the Institution of Mechanical 462 

Engineers, Part C: Journal of Mechanical Engineering Science. 211 (1), 55–76, doi: 463 
10.1243/0954406971521665 (1997). 464 

2. Lindken, R., Rossi, M., Große, S., Westerweel, J. Micro-Particle Image Velocimetry (µPIV): 465 
Recent developments, applications, and guidelines. Lab on a Chip. 9 (17), 2551, doi: 466 
10.1039/b906558j (2009). 467 

3. Hove, J.R., Köster, R.W., Forouhar, A.S., Acevedo-Bolton, G., Fraser, S.E., Gharib, M. 468 
Intracardiac fluid forces are an essential epigenetic factor for embryonic cardiogenesis. 469 
Nature. 421, 172, at <http://dx.doi.org/10.1038/nature01282> (2003). 470 

4. Ando, J., Yamamoto, K. Vascular Mechanobiology. Circulation Journal. 73 (11), 1983–1992, 471 
doi: 10.1253/circj.CJ-09-0583 (2009). 472 

5. Conway, D.E., Breckenridge, M.T., Hinde, E., Gratton, E., Chen, C.S., Schwartz, M.A. Fluid 473 
Shear Stress on Endothelial Cells Modulates Mechanical Tension across VE-Cadherin and 474 
PECAM-1. Current Biology. 23 (11), at 475 
<http://www.sciencedirect.com/science/article/pii/S0960982213004909>. (2013). 476 

6. Kuhlencordt, P.J. et al. Accelerated Atherosclerosis, Aortic Aneurysm Formation, and 477 
Ischemic Heart Disease in Apolipoprotein E/Endothelial Nitric Oxide Synthase Double-478 
Knockout Mice. Circulation. 104 (4), 448–454, doi: 10.1161/hc2901.091399 (2001). 479 

7. Lieber, B.B., Stancampiano, A.P., Wakhloo, A.K. Alteration of hemodynamics in aneurysm 480 
models by stenting: Influence of stent porosity. Annals of Biomedical Engineering. 25 (3), 481 
460–469, doi: 10.1007/BF02684187 (1997). 482 

8. Bulusu, K. V., Plesniak, M.W. Experimental Investigation of Secondary Flow Structures 483 



   

Page 11 of 13  revised November 2017 
 

Downstream of a Model Type IV Stent Failure in a 180˚ Curved Artery Test Section. Journal 484 
of Visualized Experiments. (113), e51288–e51288, doi: 10.3791/51288 (2016). 485 

9. Tseng, Q. et al. Spatial organization of the extracellular matrix regulates cell-cell junction 486 
positioning. Proceedings of the National Academy of Sciences of the United States of 487 
America. 109 (5), 1506–11, doi: 10.1073/pnas.1106377109 (2012). 488 

10. Shavit, U., Lowe, R.J., Steinbuck, J. V Intensity Capping: a simple method to improve cross-489 
correlation PIV results. Experiments in Fluids. 42 (2), 225–240, doi: 10.1007/s00348-006-490 
0233-7 (2007). 491 

11. M. Raffel, C. Willert, S. Werely, J.K. Particle Image Velocimetry: a Practical Guide. Springer. 492 
New York. (2007). 493 

12. Kerl, H.U. et al. Implantation of Pipeline Flow-Diverting Stents Reduces Aneurysm Inflow 494 
Without Relevantly Affecting Static Intra-aneurysmal Pressure. Neurosurgery. 74 (3), 321–495 
334, at <http://dx.doi.org/10.1227/NEU.0000000000000253> (2014). 496 

13. Lieber, B.B., Livescu, V., Hopkins, L.N., Wakhloo, A.K. Particle Image Velocimetry 497 
Assessment of Stent Design Influence on Intra-Aneurysmal Flow. Annals of Biomedical 498 
Engineering. 30 (6), 768–777, doi: 10.1114/1.1495867 (2002). 499 

14. Charonko, J., Karri, S., Schmieg, J., Prabhu, S., Vlachos, P. In vitro, time-resolved PIV 500 
comparison of the effect of stent design on wall shear stress. Annals of biomedical 501 
engineering. 37 (7), 1310–21, doi: 10.1007/s10439-009-9697-y (2009). 502 

15. Rand, P.W., Lacombe, E., Hunt, H.E., Austin, W.H. Viscosity of normal human blood under 503 
normothermic and hypothermic conditions. Journal of Applied Physiology. 19 (1), 117–504 
122, doi: 10.1152/jappl.1964.19.1.117 (1964). 505 

16. Kenner, T., Leopold, H., Hinghofer-Szalkay, H. The continuous high-precision measurement 506 
of the density of flowing blood. Pflügers Archiv European Journal of Physiology. 370 (1), 507 
25–29, doi: 10.1007/BF00707941 (1977). 508 

17. Hoyt, L.F. New Table of the Refractive Index of Pure Glycerol at 20°C. Industrial & 509 
Engineering Chemistry. 26 (3), 329–332, doi: 10.1021/ie50291a023 (1934). 510 

18. Cai, Z., Qiu, W., Shao, G., Wang, W. A new fabrication method for all-PDMS waveguides. 511 
Sensors and Actuators A: Physical. 204, 44–47, doi: 512 
https://doi.org/10.1016/j.sna.2013.09.019 (2013). 513 

19. Bouillot, P., Brina, O., Ouared, R., Lovblad, K.-O., Farhat, M., Pereira, V.M. Particle imaging 514 
velocimetry evaluation of intracranial stents in sidewall aneurysm: hemodynamic 515 
transition related to the stent design. PloS one. 9 (12), e113762, doi: 516 
10.1371/journal.pone.0113762 (2014). 517 

20. Trager, A.L., Sadasivan, C., Lieber, B.B. Comparison of the in vitro hemodynamic 518 
performance of new flow diverters for bypass of brain aneurysms. Journal of 519 
biomechanical engineering. 134 (8), 084505, doi: 10.1115/1.4006454 (2012). 520 

21. Clauser, J. et al. A Novel Plasma-Based Fluid for Particle Image Velocimetry (PIV): In-Vitro 521 
Feasibility Study of Flow Diverter Effects in Aneurysm Model. Annals of Biomedical 522 
Engineering. 46 (6), 841–848, doi: 10.1007/s10439-018-2002-1 (2018). 523 

22. Johnston, I.D., McCluskey, D.K., Tan, C.K.L., Tracey, M.C. Mechanical characterization of 524 
bulk Sylgard 184 for microfluidics and microengineering. Journal of Micromechanics and 525 
Microengineering. 24 (3), 035017, doi: 10.1088/0960-1317/24/3/035017 (2014). 526 

23. Lee, J.N., Park, C., Whitesides, G.M. Solvent Compatibility of Poly(dimethylsiloxane)-Based 527 



   

Page 12 of 13  revised November 2017 
 

Microfluidic Devices. Analytical Chemistry. 75 (23), 6544–6554, doi: 10.1021/ac0346712 528 
(2003). 529 

24. Meinhart, C.D., Wereley, S.T., Santiago, J.G. A PIV Algorithm for Estimating Time-Averaged 530 
Velocity Fields. Journal of Fluids Engineering. 122 (2), 285, doi: 10.1115/1.483256 (2000). 531 

25. Bosbach, J., Kühn, M., Wagner, C., Raffel, M., Resagk, C. Large-Scale Particle Image 532 
Velocimetry of Natural and Mixed Convection. 13th Int Symp on Applications of Laser 533 
Techniques to Fluid Mechanics (2006). 534 

26. Meinhart, C.D., Wereley, S.T., Santiago, J.G. PIV measurements of a microchannel flow. 535 
Experiments in Fluids. 27 (5), 414–419, doi: 10.1007/s003480050366 (1999). 536 

27. Lima, R. et al. In vitro blood flow in a rectangular PDMS microchannel: experimental 537 
observations using a confocal micro-PIV system. Biomedical Microdevices. 10 (2), 153–167, 538 
doi: 10.1007/s10544-007-9121-z (2008). 539 

28. Kuo, C.-C., Mao, R.-C. Development of a Precision Surface Polishing System for Parts 540 
Fabricated by Fused Deposition Modeling. Materials and Manufacturing Processes. 31 (8), 541 
1113–1118, doi: 10.1080/10426914.2015.1090594 (2016). 542 

29. Kang, K., Oh, S., Yi, H., Han, S., Hwang, Y. Fabrication of truly 3D microfluidic channel using 543 
3D-printed soluble mold. Biomicrofluidics. 12 (1), 014105, doi: 10.1063/1.5012548 (2018). 544 

30. Prasad, A.K. Particle Image Velocimetry. Current Science. 79 (1), 51–60 (2000). 545 
31. Dellenback, P.A., Macharivilakathu, J., Pierce, S.R. Contrast-enhancement techniques for 546 

particle-image velocimetry. Applied Optics. 39 (32), 5978–5990, doi: 547 
10.1364/AO.39.005978 (2000). 548 

32. Cowen, E.A., Monismith, S.G. A hybrid digital particle tracking velocimetry technique. 549 
Experiments in fluids. 22 (3), 199–211 (1997). 550 

33. Gruen, A.W. Adaptive least squares correlation: a powerful image matching technique. 551 
South African Journal of Photogrammetry, Remote Sensing and Cartography. 14 (3), 175–552 
187, at 553 
<http://citeseerx.ist.psu.edu/viewdoc/summary;jsessionid=8478C7133B070BA354E5DED554 
2EFF60262?doi=10.1.1.93.6891\nhttp://www.idb.arch.ethz.ch/files/alsm_awgruen.pdf> 555 
(1985). 556 

34. Nogueira, J., Lecuona, A., Rodríguez, P.A. Data validation, false vectors correction and 557 
derived magnitudes calculation on PIV data. Measurement Science and Technology. 8 (12), 558 
1493–1501, doi: 10.1088/0957-0233/8/12/012 (1997). 559 

35. Loudon, C., Tordesillas, A. The Use of the Dimensionless Womersley Number to 560 
Characterize the Unsteady Nature of Internal Flow. Journal of Theoretical Biology. 191 (1), 561 
63–78, doi: https://doi.org/10.1006/jtbi.1997.0564 (1998). 562 

36. Drost, S., De Kruif, B.J., Newport, D. Arduino control of a pulsatile flow rig. Medical 563 
Engineering and Physics. 51, 67–71, doi: 10.1016/j.medengphy.2017.10.006 (2017). 564 

37. Tsai, W., Savaş, Ö. Flow pumping system for physiological waveforms. Medical & Biological 565 
Engineering & Computing. 48 (2), 197–201, doi: 10.1007/s11517-009-0573-6 (2010). 566 

38. Kato, T., Indo, T., Yoshida, E., Iwasaki, Y., Sone, M., Sobue, G. Contrast-enhanced 2D cine 567 
phase MR angiography for measurement of basilar artery blood flow in posterior 568 
circulation ischemia. AJNR. American journal of neuroradiology. 23 (8), 1346–51, at 569 
<http://www.ncbi.nlm.nih.gov/pubmed/12223376> (2002). 570 

 571 



 

Page 0 of 21  revised November 2017 

TITLE: Simplified protocol for meso-scale particle image velocimetry studies of neurovascular 1 
flows in vitroin vitro  2 
 3 
AUTHORS AND AFFILIATIONS:  4 
Ryan A. Peck1*, Edver Bahena1*, Reza Jahan2, Guillermo Aguilar1,3,4, Hideaki Tsutsui1,4, Marko 5 
Princevac1, Monica M. Wilhelmus1, and Masaru P. Rao1,3,4 6 
 7 
1 Department of Mechanical Engineering, University of California, Riverside, CA, USA 8 
2 Division of Interventional Neuroradiology, University of California, Los Angeles, California, USA  9 
3 Materials Science and Engineering Program, University of California, Riverside, CA, USA 10 
4 Department of Bioengineering, University of California, Riverside, CA, USA 11 
 12 
*Contributed Equally 13 
 14 
Authors: 15 
Ryan A. Peck: rpeck003@ucr.edu 16 
Edver Bahena: ebahe002@ucr.edu 17 
Reza Jahan: rjahan@mednet.ucla.edu 18 
Guillermo Aguilar: gaguilar@engr.ucr.edu 19 
Hideaki Tsutsui: htsutsui@engr.ucr.edu 20 
Marko Princevac: marko@engr.ucr.edu 21 
Monica M. Wilhelmus: monicamo@engr.ucr.edu 22 
 23 
Corresponding Author:  24 
Masaru P. Rao 25 
mprao@engr.ucr.edu 26 
 27 
 28 
 29 
 30 
KEYWORDS:  31 
Particle Image Velocimetry, PDMS Tissue Phantom, 3D Printing, Fluid Mechanics, Signal 32 
Processing, Neurovascular.  33 
 34 
SUMMARY:  35 
Within this protocol we detail simplified methods for fabricating transparent neurovascular 36 
phantoms and characterizing flow therein. We highlight several important parameters and 37 
demonstrate their relationship to field accuracy. 38 
 39 
ABSTRACT:  40 
Particle Image Velocimetry (PIV) is used in a wide variety of fields, due to the opportunity it 41 
provides for precisely visualizing and quantifying flows across a large spatiotemporal range. 42 
However, its implementation typically requires use of expensive and specialized instrumentation, 43 
which limits its broader utility. Moreover, within the field of bioengineering, in vitro flow 44 

Formatted: Font: Italic

Revised Manuscript (PDF Format) Click here to access/download;Supplemental File (Figures,
Permissions, etc.);JoVE58902R1_MARKED.pdf

mailto:rpeck003@ucr.edu
mailto:ebahe002@ucr.edu
mailto:RJahan@mednet.ucla.edu
mailto:gaguilar@engr.ucr.edu
mailto:htsutsui@engr.ucr.edu
mailto:marko@engr.ucr.edu
mailto:monicamo@engr.ucr.edu
mailto:mprao@engr.ucr.edu
http://www.editorialmanager.com/jove/download.aspx?id=899540&guid=67590a00-22b9-4219-8dc8-e22d68f0967e&scheme=1
http://www.editorialmanager.com/jove/download.aspx?id=899540&guid=67590a00-22b9-4219-8dc8-e22d68f0967e&scheme=1


   

Page 1 of 21  revised November 2017 
 

visualization studies are also often further limited by the high cost of commercially-sourced tissue 45 
phantoms that recapitulate desired anatomical structures, particularly for those that span the 46 
meso-scale regime (i.e., sub-mm to mm length-scales). Herein, we present a simplified 47 
experimental protocol developed to address these limitations, the key elements of which include: 48 
1) a relatively low-cost method for fabricating meso-scale tissue phantoms using 3D printing and 49 
silicone casting; and 2) an open-source image analysis and pre/post-processing framework that 50 
reduces demand upon the instrumentation for measuring meso-scale flows (i.e., velocities up to 51 
tens of mm/s). Collectively, this lowers the barrier to entry for non-experts by leveraging 52 
resources already at the disposal of many bioengineering researchers. , thus circumventing the 53 
applicability of this protocol within the context of neurovascular flow characterization; however, 54 
it is expected to be relevant to a broader range of meso-scale applications in bioengineering and 55 
beyond. 56 
 57 
INTRODUCTION:  58 
Particle image velocimetry (PIV) is widely used in experimental fluid mechanics for flow 59 
visualization and quantitative investigations of fluid motion that vary in length-scale from 60 
atmospheric to microcirculatory flows1–3. While the specifics of its implementation can vary as 61 
widely as its applications, one aspect common to nearly all PIV studies is the use of video imaging 62 
of tracer particles seeded within the working fluid, followed by pair-wise analysis of consecutive 63 
image frames to extract desired flow characteristics. Typically, this is accomplished by first sub-64 
dividing each image frame into smaller regions termed interrogation windows. As a consequence 65 
of the random positions of the dispersed particles, each interrogation window contains a unique 66 
distribution of pixel intensities. If the window size and data acquisition rate are chosen 67 
appropriately, cross-correlation of the intensity signal in each window can be used to estimate 68 
the average displacement within that region. Finally, given that the magnification and frame rate 69 
are known experimental parameters, an instantaneous velocity vector field can be readily 70 
computed.  71 
 72 
A major advantage of PIV over single-point measurement techniques is its ability to map vector 73 
fields across a two- or three-dimensional domain. Hemodynamic applications, in particular, have 74 
benefited from this capability, since it allows a thorough investigation of local flows, which are 75 
known to play a significant role in vascular disease or remodeling (e.g., atherosclerosis, 76 
angiogenesis)4–6. This has also been true for the evaluation of neurovascular flows, and the 77 
interactions thereof with endovascular devices (e.g., flow diverters, stents, intra-saccular coils, 78 
etc.), since the relevant lengths-scales in such applications can often span one or more orders of 79 
magnitude (e.g., micrometer to mm-scale), and device geometry and placement can significantly 80 
impact the local fluid mechanics7.   81 
 82 
Most groups conducting PIV-based hemodynamics studies have relied on experimental setups 83 
that closely mimic some of the earliest investigations of stent influence on vascular flow7, 8. 84 
Typically, these include: a) pulsed lasers and high-speed cameras, to capture high velocity flows; 85 
b) synchronizers, to prevent aliasing between the pulse frequency of the laser and the camera 86 
acquisition frame rate; c) cylindrical optics, to form a light sheet, and thus, minimize background 87 
fluorescence from tracer particles above and below the interrogation plane; and d) in the case of 88 
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commercial turn-key systems, proprietary software packages, to perform the cross-correlation 89 
analyses. However, while some applications require the performance and/or versatility 90 
collectively afforded by these components, many others do not, thus making it sometimes 91 
difficult to justify the high cost of such systems. (which can reach up to > $100k). . Moreover, the 92 
high cost of commercially-sourced tissue phantoms that recapitulate desired vascular structures 93 
can also prove limiting for many in vitroin vitro studies, particularly for phantoms with features 94 
that bridge the meso-scale regime (> $500/phantom). It must be emphasized that the intent of 95 
this protocol is to outline a methodology to perform PIV with lab components that are already 96 
accessible to bioengineering laboratories. It is out of the scope of this document to provide a 97 
detailed guide on PIV and the reader is referred to comprehensive texts for variations on the 98 
method (CITE). Here, we lay out a fail-proof framework that can be readily applied even if one 99 
lacks experience with this measurement technique. Herein, we report the development of a 100 
simplifiede and low-cost protocol for implementing PIV for in vitro visualization of neurovascular 101 
flows, which typically lie both spatially and temporally within the meso-scale regime (i.e., length-102 
scales ranging from sub-mm to mm, and velocities up to tens of mm/s). The protocol seeks to 103 
leverage resources already at the disposal of many bioengineering researchers, thus lowering the 104 
barrier to entry for non-experts. 105 
 106 
It must be emphasized that the intent of this protocol is to outline a methodology to perform PIV 107 
in-house fabrication of transparent, polydimethylsiloxane (PDMS)silicone-based tissue phantoms 108 
from 3D-printed sacrificial acrylonitrile butadiene styrene (ABS) molds. By leveraging the 109 
increasing availability of 3D printers in recent years, particularly those in shared/multi-user 110 
facilities (e.g., institutional facilities or public makerspaces), this methodology cuts cost 111 
significantly (e.g., < $100/phantom in our case), while enabling rapid turnaround for fabrication 112 
of a wide variety of designs and geometries. In the current protocol, a fused deposition modeling 113 
system is used with acrylonitrile butadiene styrene (ABS) as the build material, and the printed 114 
part serves as a sacrificial mold for the subsequent phantom casting. Our experience has shown 115 
that ABS is well-suited for such use, since it is soluble in common solvents (e.g., acetone), and it 116 
has sufficient strength and rigidity to maintain mold integrity after removal of the support 117 
material (e.g., to prevent deformation or fracture of diminutive mold features). In the current 118 
protocol, mold integrity is further ensured through the use of solid printed models, although this 119 
comes at the expense of increased dissolution time. Use of hollow models may also possible in 120 
some cases, to enhance solvent access, and thus, reduce dissolution time. However, careful 121 
consideration should be given to the effect this may have on mold integrity. Finally, while the 122 
phantoms fabricated herein are based upon idealized representations of neurovascular 123 
structures generated using a common CAD software package, the protocol is expected to be 124 
amenable to the fabrication of more complex, patient-specific geometries as well (e.g., via use of 125 
model files generated by conversion of clinical imaging data into the .STL file format used by most 126 
3D printers). Further details regarding the phantom fabrication process are provided in Protocol 127 
Section s 1 and 2 of the Protocol. 128 
 129 
The second element of the protocol involves the use of an open-source plug-in for ImageJ to 130 
conduct the cross-correlation analyses9. This is coupled with the implementation of a simple 131 
statistical thresholding scheme (i.e. intensity capping)10 to improve image signal prior to cross-132 
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correlation, and as well as a post-correlation vector validation scheme, the normalized median 133 
(NMT), to eliminate spurious vectors through comparison of each to its nearest neighbors11. 134 
Collectively, this allows imaging to be accomplished using equipment commonly found in many 135 
bioengineering laboratories (e.g., fluorescence microscope with filtered, continuous white light), 136 
thus eliminating the need for acquisition of many of the costly components of typical PIV systems 137 
(e.g., pulsed laser, synchronizer, cylindrical optics, and proprietary software). Further details 138 
regarding the video collection, image processing, and data analysis are provided in Sections 5 and 139 
6 of the Protocol. 140 
 141 
Figure 1 illustrates the various components of the PIV setup used in this studyprotocol, which 142 
relies upon a fluorescence microscope equipped with a high-speed camera for imaging, as well 143 
as an external, continuous white-light source (i.e., metal halide lamp) for through-objective 144 
volumetric illumination. A , which also includes a variable-speed gear pump is used to to 145 
enableimpose recirculating flow of a transparent mock blood solution of a transparent mock 146 
blood solution through PDMS-basedthe neurovascular tissue phantoms. The solution  is 147 
composed of a 60:40 mixture of DI water and glycerol, which is a common substitute for blood 148 
in hemodynamics studies12–14,  due to: a) its similar density and viscosity, i.e. 1080 kg/m3 & 3.5 149 
cP, vs. 1050 kg/m3 & 3.0 – 5.0 cP for blood15, 16; b) its transparency in the visible range; c) its 150 
similar refractive index as PDMS (1.38 vs. 1.42 for PDMS)17–20 20, 21, which minimizes optical 151 
and d) the ease with which non-Newtonian behavior can be introduced, if needed, via the 152 
addition of xanthane21. Finally, fluorescent polystyrene beads are used as tracer particles (10.3 153 
μm diameter; 480 nm/501 nm excitation/emission). While neutrally-buoyant beads are desired, 154 
sourcing tracer particles with optimal fluid mechanical properties (e.g., density, size, 155 
composition) and emission wavelength can prove challenging. For example, the beads used 156 
herein are slightly less dense than the glycerol solution (1050 kg/m3 vs. 1080 kg/m3). However, 157 
the hydrodynamic effects thereof are negligible, given that the duration of a typical experiment 158 
is far shorter than the time scale associated with buoyancy effects (i.e., 5 min & 20 min, 159 
respectively). Further details regarding the mock blood solution formulation and , in vitro 160 
circulatory system setupvideo collection, image processing, and data analysis are provided in 161 
Sections 3 and 4 of the Protocol Sections 3 to 5.  162 
 163 
PROTOCOL:  164 
1. ABS-BASED SACRIFICIAL MOLD FABRICATION 165 

1.1. Design an inverse model of the desired tissue phantom using CAD software. 166 
1.1.2. Print the model using a 3D printer with ABS as the build material. 167 
 Design inverse model of desired tissue phantom using CAD software. The design used in 168 
2.1. Mixing 169 

2.1.1. In a disposable weigh boat, Mix the PDMS prepolymer base and curing agent in a 170 
mixture provides sufficient material for fabrication of phantoms with volumes up to 171 
50XXX mcm3 of 60g base to 6g curing agent for 5 to 10 min. 172 

 Place the mixture in a vacuum desiccator for 60 min to degas and minimize bubble 173 
 entrapment. Use cyclic pressurization/depressurization to facilitate bubble 174 

- Casting  175 
2.2.1. Mount the printed ABS mold on a glass slide using molding putty to seal the 176 
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interfaceMount printed ABS mold on a 75mm x 25mm glass slide such so that the top 177 
- Carefully pour the PDMS mixture into the mold while trying to minimize bubble 178 

entrapment. Lingering bubbles can be manually ruptured using a needlePour PDMS 179 
2.2. Curing  180 

temperatures this process can be accelerated22.  181 

2.3. Demolding 182 
2.3.1. Dissolve the ABS by submerging the phantom in acetone and sonicating for at least 183 

15 min using powers up to 70 W.  184 
  185 

- Place in ultrasonicaultrasonic bath to facilitate the dissolving of the ABS. 186 
-  187 

2.3.2. Thoroughly rinse the phantom with isopropyl alcohol, and then DI water to remove 188 
solvent residuesRinse phantom with isopropyl alcohol and DI water and check to 189 

  190 
-  191 
phantom is rinsed and dried sufficiently23. 192 

o  193 
2.4. Phantom fidelity verification  194 

2.4.1. Using an optical microscope with attached camera and image capture software, 195 
capture an image of a critical feature within the phantom under a magnification that 196 
maximizes the feature within the field of view. 197 

- Save the imagean image of the phantom under magnification. (For the example data 198 
2.4.3. Load both images into ImageJ by dragging them onto the “ImageJ Ttoolbar”. 199 
2.4.4. MakeClick on  the calibration reticle image to make it active, and then select the 200 

“Lline” tool. Using the mouse, d Draw a line along a feature of a known distance and 201 
select “Analyze” > “Set Scale…” from the ImageJ menu.  202 

2.4.5. In the “Sset Sscale” window, the field labeled “Distance in pixels” should be pre-203 
populated with the length of the drawn line in units of pixels. Enter the length of the 204 
feature on the calibration window in the field labeled “Known Ddistance”, and its units 205 
in the field labeled “Unit of Llength”. Check the box labeled “Global” to apply this 206 
calibration factor to all open images. 207 

2.4.6. Make the image of the phantom critical feature active and use the “Lline” tool to 208 
draw a line along a feature of interest. 209 

2.4.7. From the ImageJ menu, select “Analyze” > “Measure” (or press Ctrl + M) to measure 210 
the length of the line. 211 

 Compare the expected value against the value in the column marked “Llength” in the 212 
the “Results” window to confirm phantom fidelity. 213 

3. MOCK BLOOD SOLUTION FORMULATION 214 
3.1. Mix DI water and glycerol in a 60:40 ratio (by volume). A 100 mL volume is sufficient for 215 

the in vitro circulatory system described hereinMix 100 mL of 60:40 solution of DI water 216 
3.1.   217 
mock blood solution.    218 

3.2.3.3. n and Hhomogenize the mixture on a magnetic stir plateplate at 400 rpm for 10 min.  219 
- 10.3 µm diameter beads with 480 nm/501 nm excitation/emission wavelengths 220 
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4.1. Pump Setup 221 
4.1.1. Use a wire stripper tool to cut off the DC-end plug from the A/C to DC adapter 222 

source.  223 
4.1.2. Strip the coating off the power and ground wires and connect them to the input 224 

terminal of the pulse width modulation (PWM) voltage regulator.  225 
4.1.3. Connect the power and ground wires from the pump’s DC motor to the output 226 

terminal of the PWM voltage regulator. The PWM’s 7-segment  display outputs the 227 
duty cycle (0% - 100%) used to achieve a variable voltage to the DC motor.  228 

4.2. Pump Calibration 229 
4.2.1. In a 500mL beaker,P Pprepare 1200 mL of mock blood solution (see Sas outlined in 230 
4.2.2. Place tubing from the pump inlet to the beaker holding the mock blood solution. 231 
4.2.3. Place tubing from the pump outlet to an empty 500 mL beaker.r. from the volume.  232 
4.2.4. Select a desired range of duty cycle values to duty cycle set-point (0% - 100%).  and 233 

timer.  and collect  234 
4.2.5. Stop the timer once the pump has transferred allthe entire volume of  of the mock 235 

solution. Use this time to calculate the volumetric flow rate. 236 
-4.2.6. Repeat steps 4.2.1 – 4.2.5 for at least 5 different varying flow ratesduty cycle set-237 

a least-squares regression curve. A minimum of three replicate points per duty cycle 238 
set-point is recommended. This relationship can be used to correlate the desired flow 239 
rate to the required PWM duty cycle.  240 

4.5. VIDEO COLLECTION 241 
- Image calibration 242 

 Determine calibration ratio for the video imaging (see Section 2).Within the PCC 243 
- Import this image into ImageJ to estimate the calibration constant (e.g., pixels/mm). 244 
- Place the PDMS phantom on the stage of the upright fluorescence microscope. 245 
5.2.2. Connect the phantom to thea gear pump and introduce the mock blood solution. 246 

  247 
o   248 
with mock blood solution..  , which This may be particularly beneficial for models with 249 
vessels and/or blind features (e.g., small perforators and aneurysm sacs, respectively).  250 
o   251 

5.2.3. Set the pump motor controller for the desired flow rate based on the pump 252 
calibration curve. 253 

- Run the pump for 1 to - 5 minutes prior to the experiment to ensure steady-state 254 
conditions. 255 

- Turn on the Mg-Halideexternal lamp to Iilluminate the field of view of the camera 256 
according based upon the to the excitation wavelength of the fluorescent beads. 257 

- Adjust the imaging focal plane to the vessel mid-plane. This can be achieved by : 258 
: 259 
phantoms with circular vessel cross sections); and/or  260 
feature designed to facilitate identification of the vessel mid-plane. In the example 261 

4.1. Video recording 262 
- Select the video recording parameters to optimize signal-to-noise ratio (SNR).  263 

parameters include exposure time, frame rate, and gain.  264 
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frame rate of 2000 framesfps/s,, and a gain of 1.0. However, these parameters may 265 
on application (see; refer to  Ddiscussion section for morefurther details).   266 

o1.1.1. Gain can be used to amplify the signal, but this also increases sensor noise. 267 
- Phantom clean up 268 

- If bead-sticking is observed after an experiment, sonicate the phantom in an aqueous 269 
aqueous Alconox detergent solution using powers up to 70 W.  270 

5.6. IMAGE PROCESSING AND DATA ANALYSIS 271 
- Image pre-filteringprocessingprocessing 272 

o Drag the saved AVI file onto the IimageJ window to Iimport it. AVI file into ImageJ in 273 
“Cconvert to Ggrayscale”. 274 

- From the “ImageJ” mMenu, Sselect “Analyze” > “Generate Histogram” (or press cCtrl 275 
H) to  Intensity capping 276 
standard deviation for the unprocessed image. 277 
  278 

 NOTE: At high frame rates, it is not unusual for the distribution to be 279 
heavily toward zero (i.e., no signal). 280 

  281 
6.1.3. From the “ImageJ” ImageJ mMenu, Sselect “Image” > “Adjust”> “Brightness and 282 

press Shift + Ctrl + H) to Aapply a brightness/contrast filter.  283 
6.1.4. On the “Bbrightness and Ccontrast” menu, Ppress the “Set” button to define the 284 

limits. ChooseSet the minimum value to be  such that the intensity limits are set by 285 
set the maximum value to be the maximum intensity of the image (both based on 286 
statistics obtained in Section 5.16.1.2).  287 
  288 

o NOTE: obtained in step 5.1.2. This typically eliminates all but the top 10% 289 
of standard deviations may be varied depending on the desired distribution of 290 
pixel intensities.  291 
operation is provided in the Supplemental Material. 292 

  293 
- From the “ImageJ” ImageJ mMenu, Sselect “Process” > “Noise” > “Despeckle” .  294 

number of saturated pixels. 295 
  296 

NOTE: This operation is necessitated by the increased potential for pixel saturation 297 
that arises during optimization of brightness and contrast, which can produce 298 
spurious vectors during subsequent cross-correlation. 299 

  300 
- From the “ImageJ” ImageJ mMenu, Sselect “Process” > “Filters” > “ Gaussian Blur” 301 

radius of 1.5 to reduce artifacts arising from the . Select the radius to be 1.5. This value 302 
pixels in a 3x3 neighborhood by the prior despeckling operation. 303 

o Click on the “Ppolygon” tool, and then click within the image to outline the The 304 
interest (ROI).  305 

- From the “ImageJ” ImageJ mMenu, select “Edit” > “Clear Outside”  definitionto 306 
locations where no signal is expected (e.g., areas beyond vessel wall boundary), which 307 
can decrease overall SNR. 308 
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o The ImageJ ROI Definition function, followed by the Clear Outside function, can 309 
  310 
NOTE: This portion of the protocol e section below employs a third-party PIV plug-in for 311 
ImageJ for conducting PIV analyses, . Ensure the plug-in has been installed before 312 
implementing any of the operations below.which relies upon Gaussian peak-fitting to 313 
enable estimation of displacement with sub-pixel accuracy. 314 
-  315 

6.2.1. From the “ImageJ” ImageJ mMenu, Cross-correlationSselect “Plugins” > “Macros” 316 
saved macro “Supplemental Codde 2.ijjm” to perform a batched correlation oncross-317 
 318 

NOTE: The code performs an algorithmmacro isproceeds as follows: 319 
within consecutive images is first performed to determine the local displacement 320 
of advected tracer particles, i.e.  (i.e. the first image pair isconsists of the first and 321 
imagesimages #1 and #2, and the second image pair pair isconsists of the second 322 
two-step multi-pass evaluation was adoptedis then performed with initial and 323 
interrogation window sizes of 256 x 256 pixels and 128 x 128 pixels, respectively; 324 
and finally, 3) . After the correlation is performed for all image pairs, the macro 325 
potential for introductionappearance of spurious vectors. 326 
o  327 

6.3. Normalized median test (NMT) 328 
6.3.1. From the “ImageJ” ImageJ mMenu, select “Plugins” > “Macros” > “Run…” and 329 

saved macro “Supplemental Code 3.ijjm” to perform a batched vector validation 330 
normalized median test.  331 
 332 

 NOTE: The macro algorithm performsisproceeds as follows: 1) Perform 333 
field is first compared to its eight nearest neighbors andto compute the median 334 
2) . 335 
neighboring vector and the median vector magnitudecalculated median; .3) t 336 
vector under investigation and the median neighboring vector value is then 337 
normalized by the median of the residuals; 4) . 338 
value (typically 0.2 pixels), which can be varied based on a priori knowledge of 339 
noise during image acquisition; and finally, 5) . 340 
instantaneous vector fields before averaging them, since is performed to produce 341 
a composite field, as this has been shown to increase the vector field quality24. 342 

o  343 
REPRESENTATIVE RESULTS:   344 
Figure 2 illustrates the PDMS tissue phantom fabrication process. The phantoms designed herein 345 
are intended for the study of flow in idealized wide-necked, saccular, intracranial aneurysms, as 346 
well as proximal branching perforator arteries. Important additional design features include: 1) a 347 
common reservoir that all vessels drain into, to ensure unencumbered fluid egress from the 348 
phantom, otherwise droplet formation may occur at the smaller vessel outlets; 2) a bubble trap, 349 
to facilitate bubble removal; 3) an outer cavity wall, to ensure parallelism of the vessel with the 350 
horizontal plane, as well as precise definition of the final phantom slab height, length and width; 351 
and 4) use of a 21 gauge hypodermic needle shank (820 µm nominal outer diameter) for molding 352 
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of the perforator artery, due to our printer’s inability to define such features with sufficient 353 
fidelity. Faithful reproduction of all design features is observed throughout. 354 
 355 
Representative results for PIV-based flow characterization performed using the current protocol 356 
are presented in Figures 3 and 4. These studies were performed using phantom inlet flow rates 357 
of 100 mL/min, data acquisition rates of 2000 fps, and temporal averaging over spans of 0.05 s. 358 
Figure 3 shows representative image frames within the perforator artery, before and after 359 
intensity capping as well as corresponding surface plots of the 8-bit pixel intensity values. Both 360 
demonstrate that intensity capping significantly increases peak definition above the noise floor 361 
(i.e., increases SNR), which is critical to ensuring accuracy when performing subsequent cross-362 
correlation. Figure 4 shows the effects of intensity capping and NMT operations on the velocity 363 
vector field. Marked improvement in field uniformity is observed, thus further underscoring the 364 
importance of maximizing SNR to minimize data dropout.  365 
 366 
FIGURE AND TABLE LEGENDS:  367 
 368 
 369 
  370 
Figure 2: PDMS-based tissue phantom fabrication process: a) CAD model of neurovascular 371 
phantom mold; b) Printed ABS mold, after removal of support material; c) Casting and curing of 372 
PDMS within the ABS mold; d) Partial dissolution of ABS mold material; and e) Completed PDMS 373 
phantom, with inset showing final dimensions of key critical features, as well as the region of 374 
interest (ROI) in the perforator artery where the PIV measurements were made. .  375 
 376 
Figure 3: Effect of intensity capping operation on image SNR. Representative image frame and 377 
corresponding pixel intensity surface plots within the perforator artery, before (a, b) and after 378 
applying the intensity capping operation (c, d). 379 
 380 
Figure 4: Effects of intensity capping and NMT operations on velocity vector fields: 381 
Representative instantaneous velocity vector field within the perforator artery derived from: (a) 382 
unprocessed image data; (b) intensity capped data; and (c) intensity capped data + NMT post-383 
processing.  384 
 385 
Figure 5: Effect of interrogation window sizing on correlation quality. Optimal window sizing 386 
occurs when the value of the zero-normalized correlation coefficient is maximized, and the 387 
standard deviation is minimized. 388 
 389 
DISCUSSION:  390 
The protocol described herein outlines a simplifiede and relatively low-cost method for 391 
performing PIV studies to visualize neurovascular flows at physiologically-relevant dimensions 392 
and flow conditions in vitroin vitro. In doing so, it serves to complement protocols reported by 393 
others that have also focused on simplifying the quantification of ying vector fields, but within 394 
very different contexts that require consideration of far larger length-scales2523 or lower flow 395 
rates26, 27(e.g. atmospheric or microcirculatory flows), and thus, reliance upon simplification 396 
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schemes that are incompatible with the current application.  397 
 398 
o The most important considerations for successful implementation of PIV lie in the 399 
of flow field artifacts and maximization of image quality. Several steps in the tissue phantom 400 
fabrication process are critical to both of these criteria. For example, thorough degassing is crucial 401 
since air entrained within the PDMS during mixing can lead to bubble formation within the final 402 
phantom, which can adversely affect both feature fidelity and optical clarity. Additionally, 403 
minimization of surface roughness of the ABS mold is desired, since the PDMS casting process 404 
faithfully reproduces even the most minute imperfections (e.g., build lines, surface pores, 405 
scratches, etc.), thus resulting in surface roughness in the final phantom that can decrease optical 406 
clarity and increase potential for bead accumulation. While the protocol described herein has 407 
proven sufficient for the current applicationbeyond the scope of the current protocol, , there are 408 
means for reducing such roughness, should there be need (e.g., acetone vapor smoothing28, or 409 
optimization of layer thickness and part orientation with respect to build direction)29). 410 
 411 
 412 

 413 

𝑓𝑠𝑎𝑚𝑝𝑙𝑖𝑛𝑔 >
𝑣𝑚𝑎𝑥∙𝑐𝑐𝑎𝑙𝑖𝑏𝑟𝑎𝑡𝑖𝑜𝑛

ℎ𝑖𝑛𝑡𝑒𝑟𝑟𝑜𝑔𝑎𝑡𝑖𝑜𝑛 𝑤𝑖𝑛𝑑𝑜𝑤
 (1) 414 

 415 
where fsampling is the camera acquisition rate (Hz), vmax is the maximum expected velocity (mm/s), 416 
ccalibration is the calibration constant (pixels/mm), and hinterrogation window is the size of the 417 
interrogation window (pixels).  418 
correlation quality estimation techniques, such as the zero-normalized correlation coefficient11. 419 
In this technique, the averages of complementary signals from each frame-pair are first 420 
subtracted, and then normalized by the standard deviation of their intensities11. If a displacement 421 
of the original signal exists, such that all peaks and valleys match, the time-shifted value of this 422 
signal will be equal to one. Conversely, if there is no displacement that can align these signals, 423 
the value will be zero. This information is included in the ImageJ PIV output for each vector, and 424 
it can be plotted as its own field to see ifverify whether there are spatial effects contributing to 425 
correlation (e.g., uneven lighting). The correlation coefficient can also be averaged over a field as 426 
an overall estimate of its quality. Finally, this quantity may also be plotted against varying frame 427 
rates or interrogation window sizes to determine an optimum. Figure 5 illustrates the results 428 
from such an analysis using a Monte-Carlo synthesized particle field with displacements 429 
consistent with our experimentally-measured flows (a typical technique for characterizing 430 
correlation quality11). The results show that the interrogation window size and frame rate should 431 
be chosen such that a particle field is displaced by ≤ 20% of the interrogation window size per 432 
frame-pair to maximize the correlation coefficient, while minimizing its variability.  433 
 434 
 435 
 436 
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visualization studies are also often further limited by the high cost of commercially-sourced tissue 45 
phantoms that recapitulate desired anatomical structures, particularly for those that span the 46 
meso-scale regime (i.e., sub-mm to mm length-scales). Herein, we present a simplified 47 
experimental protocol developed to address these limitations, the key elements of which include: 48 
1) a relatively low-cost method for fabricating meso-scale tissue phantoms using 3D printing and 49 
silicone casting; and 2) an open-source image analysis and pre/post-processing framework that 50 
reduces demand upon the instrumentation for measuring meso-scale flows (i.e., velocities up to 51 
tens of mm/s). Collectively, this lowers the barrier to entry for non-experts by leveraging 52 
resources already at the disposal of many bioengineering researchers. , thus circumventing the 53 
need to implement many of the more costly components in standard PIV systems. We 54 
demonstrate the applicability of this protocol within the context of neurovascular flow 55 
characterization; however, it is expected to be relevant to a broader range of meso-scale 56 
applications in bioengineering and beyond. 57 
 58 
INTRODUCTION:  59 
Particle image velocimetry (PIV) is widely used in experimental fluid mechanics for flow 60 
visualization and quantitative investigations of fluid motion that vary in length-scale from 61 
atmospheric to microcirculatory flows1–3. While the specifics of its implementation can vary as 62 
widely as its applications, one aspect common to nearly all PIV studies is the use of video imaging 63 
of tracer particles seeded within the working fluid, followed by pair-wise analysis of consecutive 64 
image frames to extract desired flow characteristics. Typically, this is accomplished by first sub-65 
dividing each image frame into smaller regions termed interrogation windows. As a consequence 66 
of the random positions of the dispersed particles, each interrogation window contains a unique 67 
distribution of pixel intensities. If the window size and data acquisition rate are chosen 68 
appropriately, cross-correlation of the intensity signal in each window can be used to estimate 69 
the average displacement within that region. Finally, given that the magnification and frame rate 70 
are known experimental parameters, an instantaneous velocity vector field can be readily 71 
computed.  72 
 73 
A major advantage of PIV over single-point measurement techniques is its ability to map vector 74 
fields across a two- or three-dimensional domain. Hemodynamic applications, in particular, have 75 
benefited from this capability, since it allows a thorough investigation of local flows, which are 76 
known to play a significant role in vascular disease or remodeling (e.g., atherosclerosis, 77 
angiogenesis)4–6. This has also been true for the evaluation of neurovascular flows, and the 78 
interactions thereof with endovascular devices (e.g., flow diverters, stents, intra-saccular coils, 79 
etc.), since the relevant lengths-scales in such applications can often span one or more orders of 80 
magnitude (e.g., micrometer to mm-scale), and device geometry and placement can significantly 81 
impact the local fluid mechanics7.   82 
 83 
Most groups conducting PIV-based hemodynamics studies have relied on experimental setups 84 
that closely mimic some of the earliest investigations of stent influence on vascular flow7, 8. 85 
Typically, these include: a) pulsed lasers and high-speed cameras, to capture high velocity flows; 86 
b) synchronizers, to prevent aliasing between the pulse frequency of the laser and the camera 87 
acquisition frame rate; c) cylindrical optics, to form a light sheet, and thus, minimize background 88 
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fluorescence from tracer particles above and below the interrogation plane; and d) in the case of 89 
commercial turn-key systems, proprietary software packages, to perform the cross-correlation 90 
analyses. However, while some applications require the performance and/or versatility 91 
collectively afforded by these components, many others do not, thus making it sometimes 92 
difficult to justify the high cost of such systems. (which can reach up to > $100k). . Moreover, the 93 
high cost of commercially-sourced tissue phantoms that recapitulate desired vascular structures 94 
can also prove limiting for many in vitroin vitro studies, particularly for phantoms with features 95 
that bridge the meso-scale regime (> $500/phantom). It must be emphasized that the intent of 96 
this protocol is to outline a methodology to perform PIV with lab components that are already 97 
accessible to bioengineering laboratories. It is out of the scope of this document to provide a 98 
detailed guide on PIV and the reader is referred to comprehensive texts for variations on the 99 
method (CITE). Here, we lay out a fail-proof framework that can be readily applied even if one 100 
lacks experience with this measurement technique. Herein, we report the development of a 101 
simplifiede and low-cost protocol for implementing PIV for in vitro visualization of neurovascular 102 
flows, which typically lie both spatially and temporally within the meso-scale regime (i.e., length-103 
scales ranging from sub-mm to mm, and velocities up to tens of mm/s). The protocol seeks to 104 
leverage resources already at the disposal of many bioengineering researchers, thus lowering the 105 
barrier to entry for non-experts. 106 
 107 
It must be emphasized that the intent of this protocol is to outline a methodology to perform PIV 108 
with lab components that are already accessible to bioengineering laboratories. It is out of the 109 
scope of this document to provide a detailed guide on PIV and the reader is referred to 110 
comprehensive texts for variations on the method and optimization9, 10 (CITE). HereIn this 111 
protocol, we lay out a fail-proof framework that can be readily applied even if one lacks 112 
experience performing measurements with this technique. 113 
 114 
The first element of this protocol involves the use of an investment casting technique to enable 115 
in-house fabrication of transparent, polydimethylsiloxane (PDMS)silicone-based tissue phantoms 116 
from 3D-printed sacrificial acrylonitrile butadiene styrene (ABS) molds. By leveraging the 117 
increasing availability of 3D printers in recent years, particularly those in shared/multi-user 118 
facilities (e.g., institutional facilities or public makerspaces), this methodology cuts cost 119 
significantly (e.g., < $100/phantom in our case), while enabling rapid turnaround for fabrication 120 
of a wide variety of designs and geometries. In the current protocol, a fused deposition modeling 121 
system is used with acrylonitrile butadiene styrene (ABS) as the build material, and the printed 122 
part serves as a sacrificial mold for the subsequent phantom casting. Our experience has shown 123 
that ABS is well-suited for such use, since it is soluble in common solvents (e.g., acetone), and it 124 
has sufficient strength and rigidity to maintain mold integrity after removal of the support 125 
material (e.g., to prevent deformation or fracture of diminutive mold features). In the current 126 
protocol, mold integrity is further ensured through the use of solid printed models, although this 127 
comes at the expense of increased dissolution time. Use of hollow models may also possible in 128 
some cases, to enhance solvent access, and thus, reduce dissolution time. However, careful 129 
consideration should be given to the effect this may have on mold integrity. Finally, while the 130 
phantoms fabricated herein are based upon idealized representations of neurovascular 131 
structures generated using a common CAD software package, the protocol is expected to be 132 
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amenable to the fabrication of more complex, patient-specific geometries as well (e.g., via use of 133 
model files generated by conversion of clinical imaging data into the .STL file format used by most 134 
3D printers). Further details regarding the phantom fabrication process are provided in Protocol 135 
Section s 1 and 2 of the Protocol. 136 
 137 
The second element of the protocol involves the use of an open-source plug-in for ImageJ to 138 
conduct the cross-correlation analyses9. This is coupled with the implementation of a simple 139 
statistical thresholding scheme (i.e. intensity capping)10 to improve image signal prior to cross-140 
correlation, and as well as a post-correlation vector validation scheme, the normalized median 141 
test (NMT), to eliminate spurious vectors through comparison of each to its nearest neighbors11. 142 
Collectively, this allows imaging to be accomplished using equipment commonly found in many 143 
bioengineering laboratories (e.g., fluorescence microscope with filtered, continuous white light), 144 
thus eliminating the need for acquisition of many of the costly components of typical PIV systems 145 
(e.g., pulsed laser, synchronizer, cylindrical optics, and proprietary software). Further details 146 
regarding the video collection, image processing, and data analysis are provided in Sections 5 and 147 
6 of the Protocol. 148 
 149 
Figure 1 illustrates the various components of the PIV setup used in this studyprotocol, which 150 
relies upon a fluorescence microscope equipped with a high-speed camera for imaging, as well 151 
as an external, continuous white-light source (i.e., metal halide lamp) for through-objective 152 
volumetric illumination. A , which also includes a variable-speed gear pump is used to to 153 
enableimpose recirculating flow of a transparent mock blood solution of a transparent mock 154 
blood solution through PDMS-basedthe neurovascular tissue phantoms. The solution  is 155 
composed of a 60:40 mixture of DI water and glycerol, which is a common substitute for blood 156 
in hemodynamics studies12–14,  due to: a) its similar density and viscosity, i.e. 1080 kg/m3 & 3.5 157 
cP, vs. 1050 kg/m3 & 3.0 – 5.0 cP for blood15, 16; b) its transparency in the visible range; c) its 158 
similar refractive index as PDMS (1.38 vs. 1.42 for PDMS)17–20 20, 21, which minimizes optical 159 
distortion; and d) the ease with which non-Newtonian behavior can be introduced, if needed, via 160 
the addition of xanthane21. Finally, fluorescent polystyrene beads are used as tracer particles 161 
(10.3 μm diameter; 480 nm/501 nm excitation/emission). While neutrally-buoyant beads are 162 
desired, sourcing tracer particles with optimal fluid mechanical properties (e.g., density, size, 163 
composition) and emission wavelength can prove challenging. For example, the beads used 164 
herein are slightly less dense than the glycerol solution (1050 kg/m3 vs. 1080 kg/m3). However, 165 
the hydrodynamic effects thereof are negligible, given that the duration of a typical experiment 166 
is far shorter than the time scale associated with buoyancy effects (i.e., 5 min & 20 min, 167 
respectively). Further details regarding the mock blood solution formulation and , in vitro 168 
circulatory system setupvideo collection, image processing, and data analysis are provided in 169 
Sections 3 and 4 of the Protocol Sections 3 to 5.  170 
 171 
PROTOCOL:  172 
1. ABS-BASED SACRIFICIAL MOLD FABRICATION 173 

1.1. Design an inverse model of the desired tissue phantom using CAD software. 174 
1.1.2. Print the model using a 3D printer with ABS as the build material. 175 
 Design inverse model of desired tissue phantom using CAD software. The design used in 176 
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this protocol is an idealized sidewall aneurysm model.  177 
1.1. Saved desired CAD model in .STL format for import to 3-D Printing software.Other groups 178 

have shown the potential  179 
 Turn on printer and allow it to warm up. 180 

 While the printer is warming up, open CatalystEX. 181 

 Once CatalystEX has loaded, click on File, then from the drop down menu click “Open 182 
STL”. 183 

 Locate the .STL file you wish to print from the computer directory and click “Load”. 184 
 Once the .STL file has been imported click on the General Tab 185 
 On the right hand side under Properties select layer resolution and click .0070 186 
 Click on Model Interior and select Sparse (High density)  187 

 188 
NOTE: Sparse (Low Density) uses less material and creates a more porous modelhas more 189 
voids inside the model,. Tthis is good for a first pass print to ensure the model will work.  190 
Sparse (High Density) fills up some of the voids that would be present in the Low Density 191 
settinis less porousg,.  this is the preferred option for printing the sacrificial mold s as it 192 
reduces the probability of releasing trapped used to print the model that will be cast as 193 
it will contain less voids that could potentially release air bubbles during the casting. Solid 194 
is not need when it comes to printing the model, it adds more ABS but also takes longer 195 
to dissolve out 196 
 197 

 Modify field marked Modify Leave the field “ Number of copies” with desired number of 198 
copiesto 1 199 

 Select the desired unit scale used when making the STL file. In this case the unit of 200 
measure is millimeter.  201 

 Leave field marked “Scale” as default value (1). Leave scale at 1 202 
 Click on the Orientation Tab 203 
 Click on Auto Orient on the right hand side.  204 

 205 
NOTE: If not satisfied with the auto orient function you may use the XYZ axis to rotate it 206 
to your preference. 207 
 208 

 Click “Process STL “. After and once that’s been completed click “Add to Pack” 209 
 Click on the Pack Tab 210 
 You will see an outlineThe software will display  of the print area as well as an outline of 211 

the model. You may can click and drag the model to any spot on the print area.  212 
 213 
NOTE: If you’d like to make duplicates, click Copy for number of copies you’d like and 214 
arrange them on the print area so they don’t overlap. 215 
 216 

 When you are ready, click print to send the STL file to the 3D printer 217 
 On the printer itself, it will show that the STL file has been loaded. 218 
 Open the printer door and load the baseboard. Then lock it in place by turning the tabs 219 

at the front up 220 
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 Close the door, and on display press the button next to the prompt asking ifg the 221 
baseboard has been loaded. This will initiate the calibration step and also warm up the 222 
printer. 223 

 Once the printer has reached operating temperature it will automatically start the print 224 
 You may place the printer on Auto Shutdown by pressing the button next to the prompt 225 

and turning off the printer using the power switch 226 
 Once the print is complete open the door, unlock the baseboard, and remove it from the 227 

printer 228 
 Put on googles, lab coat, and rubber gloves 229 
 Take the baseboard with the model and place it in the NaOH base bath 230 
 Turn on the base bath and let it sit for 5 hours. This will dissolve out the support material 231 

and free the model. If after 5 hours the support material hasn’t fully dissolved, leave it in 232 
for another 5 hours.  233 

 Put on googles, lab coat, and rubber gloves 234 
 Remove the baseboard and model from the base bath and place in the sink. Leave the 235 

faucet running for about 15 minutes to ensure no base solution is left on the model or 236 
baseboard. You may then dry the model and baseboard.  237 

1.2. Print model using 3D printer.  238 
- A fused deposition modeling system is used herein, with ABS as the build material 239 

(0.635 mm resolution in build-plane, and 0.178 mm layer resolution). 240 
- ABS is well-suited for use as sacrificial mold material, since it has sufficient strength 241 

and rigidity to maintain structural integrity after removal of the support material, and 242 
it is soluble in common solvents (e.g., acetone). 243 

2.  PDMS-BASED VASCULAR PHANTOM FABRICATION 244 
2.1. Mixing 245 

2.1.1. In a disposable weigh boat, Mix the PDMS prepolymer base and curing agent in a 246 
10:1 ratio (by weight). Mmix PDMS monomer base and curing agent in 10:1 weight 247 
ratioA 66 g mixture provides sufficient material for fabrication of phantoms with 248 
volumes up to 50XXX mcm3 of 60g base to 6g curing agent for 5 to 10 min. 249 

 Place the mixture in a vacuum desiccator for 60 min to degas and minimize bubble 250 
 entrapment. Use cyclic pressurization/depressurization to facilitate bubble 251 
rupture.   252 

2.1.1.2.1.2. (Optional) Manually, Ccycleic pressurization/depressurization by turning the 253 
vacuum on and off may be used to facilitate bubble rupture. 254 

- Casting  255 
2.2.  256 

2.2.1. Mount the printed ABS mold on a glass slide using molding putty to seal the 257 
interfaceMount printed ABS mold on a 75mm x 25mm glass slide such so that the top 258 
is open to atmosphere.  using Use molding putty to seal interface. 259 

- Carefully pour the PDMS mixture into the mold while trying to minimize bubble 260 
entrapment. Lingering bubbles can be manually ruptured using a needlePour PDMS 261 
mixture to fill into the mold and rupture any bubbles that form. 262 

2.2.2.  afterward. 263 
2.2. Curing  264 
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- Cure the cast phantom at room temperature (25C) for at least 24 h. At higher 265 
temperatures this process can be accelerated22.  266 

2.3. Demolding 267 
- Submerge phantom in acetone bath for 15 min to dissolve ABS. 268 
2.2.3.  269 

2.3. Demolding 270 
2.3.1. Dissolve the ABS by submerging the phantom in acetone and sonicating for at least 271 

15 min using powers up to 70 W.  272 
  273 

- Place in ultrasonicaultrasonic bath to facilitate the dissolving of the ABS. 274 
  275 
- Refresh the acetone bath with fresh acetone once every 30 minutes. 276 
 277 
 278 
o Dissolution may be facilitated by ultrasonic agitation and/or periodic refreshing of 279 
acetone bath. 280 
 CAUTION: Acetone has high vapor pressure at room temperature and low flash 281 
point. Consequently, always work under a fume hood and away from potential 282 
ignition sources. Wear proper personal protective equipment (e.g., goggles or face 283 
shield, lab coat, acetone-resistant gloves, etc.). 284 
-  285 
 286 
  287 

2.3.2. Thoroughly rinse the phantom with isopropyl alcohol, and then DI water to remove 288 
solvent residuesRinse phantom with isopropyl alcohol and DI water and check to 289 
ensure no ABS residue is left from the 3D printed model. 290 

  291 
 292 

-  293 
 294 
 295 
 NOTE: PDMS swells upon exposure to acetone; however, swelling subsides once 296 
the phantom is rinsed and dried sufficiently23. 297 

o  298 
 299 

2.4. Phantom fidelity verification  300 
2.4. Confirm phantom fidelity using optical microscopy   301 

2.4.1. Using an optical microscope with attached camera and image capture software, 302 
capture an image of a critical feature within the phantom under a magnification that 303 
maximizes the feature within the field of view. 304 

- Save the imagean image of the phantom under magnification. (For the example data 305 
we’ve used 10x, but this value may vary based on application).  306 
  307 

2.4.2. At the same magnification, Ccapture an a still image of an theappropriate  308 
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resolution target or calibration reticle at the same magnification.save a reference 309 
image whose length is known  310 

2.4.3. Load both images into ImageJ by dragging them onto the “ImageJ Ttoolbar”. 311 
2.4.4. MakeClick on  the calibration reticle image to make it active, and then select the 312 

“Lline” tool. Using the mouse, d Draw a line along a feature of a known distance and 313 
select “Analyze” > “Set Scale…” from the ImageJ menu.  314 

2.4.5. In the “Sset Sscale” window, the field labeled “Distance in pixels” should be pre-315 
populated with the length of the drawn line in units of pixels. Enter the length of the 316 
feature on the calibration window in the field labeled “Known Ddistance”, and its units 317 
in the field labeled “Unit of Llength”. Check the box labeled “Global” to apply this 318 
calibration factor to all open images. 319 

2.4.6. Make the image of the phantom critical feature active and use the “Lline” tool to 320 
draw a line along a feature of interest. 321 

2.4.7. From the ImageJ menu, select “Analyze” > “Measure” (or press Ctrl + M) to measure 322 
the length of the line. 323 

 Compare the expected value against the value in the column marked “Llength” in the 324 
“Results” window to confirm phantom fidelity. 325 
 326 
Note: The steps above should be repeated for any measurement using a different 327 
microscope objective.  328 
   329 

-2.4.8. Verify that no or other techniques. Check to see if any ABS residue film is in the 330 
parent artery or aneurysm sac. Excess residue may be removed with an additional 331 
acetone/Isopropyl alcohol rinse.  332 

3. MOCK BLOOD SOLUTION FORMULATION 333 
3.1. Mix DI water and glycerol in a 60:40 ratio (by volume). A 100 mL volume is sufficient for 334 

the in vitro circulatory system described hereinMix 100 mL of 60:40 solution of DI water 335 
and glycerol, respectively. 336 
3.1.   337 
 338 
NOTE:  339 
- This is the standard blood substitute in hemodynamics studies15–17,  due to its : 340 
o density and viscosity (1080 kg/m3 and 3.5 cP, respectively, compared to 1050 341 
kg/m3 and 3.0 – 5.0 cP for blood)18, 19;   342 
o transparency in the visible range; and  343 
o similar refractive index as PDMS (1.41 38 compared to 1.42 for PDMS)20, 21, which 344 
minimizes optical distortion. N 345 
- Non-Newtonian behavior can be achieved with addition of xanthane, if needed22. 346 
 347 

3.2. Add 1 mL of 2.5% weight/volume fluorescent polystyrene bead solutions (i.e.,, tracer 348 
particles) to the mock blood solution.    349 

3.2.3.3. n and Hhomogenize the mixture on a magnetic stir plateplate at 400 rpm for 10 min.  350 
- 10.3 µm diameter beads with 480 nm/501 nm excitation/emission wavelengths 351 
are used in this study.  352 
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- An optimal bead volume fraction of 1% was determined empirically for the current 353 
application. Lower volume fractions may be possible with larger interrogation windows. 354 
 While neutrally-buoyant beads are desired, sourcing tracer particles with optimal 355 
fluid mechanical properties (e.g., density, size, composition) and emission wavelength can 356 
prove challenging. In this study, beads slightly less dense than the glycerol solution were 357 
used (1050 kg/m3 compared to 1080 kg/m3). However, the hydrodynamic effects thereof 358 
are negligible, given that the duration of a typical experiment is far shorter than the time 359 
scale associated with buoyancy effects (i.e., 5 min and 20 min, respectively). 360 

4. SHOULD WE ADD SETTING IT UP TO COVER THE IN VITRO PART THEY ASKED?PUMP SETUPIN- 361 
VITRO CIRCULATORY SYSTEM SETUP 362 
4.1. Pump Setup 363 

4.1.1. Use a wire stripper tool to cut off the DC-end plug from the A/C to DC adapter 364 
power source.  365 

4.1.2. Strip the coating off the power and ground wires and connect them to the input 366 
terminal of the pulse width modulation (PWM) voltage regulator.  367 

4.1.3. Connect the power and ground wires from the pump’s DC motor to the output 368 
terminal of the PWM voltage regulator. The PWM’s 7-segment  display outputs the 369 
duty cycle (0% - 100%) used to achieve a variable voltage to the DC motor.  370 

4.2. Pump Calibration 371 
4.2.1. In a 500mL beaker,P Pprepare 1200 mL of mock blood solution (see Sas outlined in 372 

section 3). (More volume may be required  for calibrating over a range of larger flow 373 
rates) 374 

4.2.2. Place tubing from the pump inlet to the beaker holding the mock blood solution. 375 
4.2.3. Place tubing from the pump outlet to an empty 500 mL beaker.r. from the volume.  376 
4.2.4. Select a desired range of duty cycle values to duty cycle set-point (0% - 100%).  and 377 

pPress the “On” button. and  Sstart a timer.  and collect  378 
4.2.5. Stop the timer once the pump has transferred allthe entire volume of  of the mock 379 

blood from the inlet beaker Apply to the outlet beaker solution. Use this time to 380 
calculate the volumetric flow rate. 381 

-4.2.6. Repeat steps 4.2.1 – 4.2.5 for at least 5 different varying flow ratesduty cycle set-382 
points  to establish a least-squares regression curve. A minimum of three replicate 383 
points per duty cycle set-point is recommended. This relationship can be used to 384 
correlate the desired flow rate to the required PWM duty cycle.  385 

4.5. VIDEO COLLECTION 386 
- Image calibration 387 
5.1.  388 

 Determine calibration ratio for the video imaging (see Section 2).Within the PCC 389 
software, click the camera icon to Ccapture a still image of the resolution target or 390 
calibration reticle. 391 

-5.1.1. Follow steps as outlined in 2.7 to obtain the calibration ratio. 392 
- Import this image into ImageJ to estimate the calibration constant (e.g., pixels/mm). 393 

- Apparatus set up 394 
5.2.  395 

- Place the PDMS phantom on the stage of the upright fluorescence microscope. 396 
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5.2.1.  397 
5.2.2. Connect the phantom to thea gear pump and introduce the mock blood solution. 398 

  399 
o   400 
  401 
 As an optional step, (Optional) the phantom may be pre-filledPre-fill the model 402 
with ethanol to facilitate full wetting, then flush and fill with mock blood solution..  , 403 
which This may be particularly beneficial for models with smaller vessels and/or blind 404 
features (e.g., small perforators and aneurysm sacs, respectively).  405 
o   406 
  407 

5.2.3. Set the pump motor controller for the desired flow rate based on the pump 408 
calibration curve. 409 

- Run the pump for 1 to - 5 minutes prior to the experiment to ensure steady-state 410 
conditions. 411 

5.2.4.  412 
- Turn on the Mg-Halideexternal lamp to Iilluminate the field of view of the camera 413 

from the top with a through-objective illumination source. Select the an appropriate 414 
filter according based upon the to the excitation wavelength of the fluorescent beads. 415 

5.2.5.  416 
- Adjust the imaging focal plane to the vessel mid-plane. This can be achieved by : 417 
o using a focal length that maximizes the imaged vessel cross-section (e.g., when using 418 

phantoms with circular vessel cross sections); and/or  419 
o5.2.6. indexing off of a phantom feature designed to facilitate identification of the vessel 420 

mid-plane. In the example provided a 10x objective is used. 421 
4.1. Video recording 422 
5.3.  423 

- Select the video recording parameters to optimize signal-to-noise ratio (SNR).  424 
o Key parameters include exposure time, frame rate, and gain.  425 
- Optimal SNR is typically achieved at the highest achievable frame rate that still allows 426 

sufficient bead exposure (maximum frame rate being limited by minimum exposure 427 
time).In this protocol we use an exposure time of  XXof XX, a frame rate of 2000 428 
framesfps/s,, and a gain of 1.0. However, these parameters may vary based on 429 
application (see; refer to  Ddiscussion section for morefurther details).   430 

5.3.1.  431 
o1.1.1. Gain can be used to amplify the signal, but this also increases sensor noise. 432 
o If the maximum velocity can be estimated from other flow parameters (e.g., inlet 433 
volumetric flow rate), then a lower bound on the required frame rate can be estimated 434 
using the following relation21: 435 
 436 

𝑓𝑠𝑎𝑚𝑝𝑙𝑖𝑛𝑔 >
𝑣𝑚𝑎𝑥∙𝑐𝑐𝑎𝑙𝑖𝑏𝑟𝑎𝑡𝑖𝑜𝑛

ℎ𝑖𝑛𝑡𝑒𝑟𝑟𝑜𝑔𝑎𝑡𝑖𝑜𝑛 𝑤𝑖𝑛𝑑𝑜𝑤
 (1) 437 

 438 
where fsampling is the camera acquisition rate (Hz), vmax is the maximum expected velocity 439 
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(mm/s), ccalibration is the calibration constant (pixels/mm), and hinterrogation window is the size 440 
of the interrogation window (pixels). 441 
o If the sampling frame rate matches fsampling, maximum local velocities are not 442 
captured via cross-correlation of image pairs, since the distance traveled by tracer 443 
particles in between frames exactly matches the length scale of the interrogation 444 
windows. Therefore, the camera should be set to acquire images at a higher frame rate. 445 
o For the current application, it was found that cross-correlation is optimized when 446 
tracer particles travel ≤ 20% of the interrogation window width per frame-pair (see 447 
Discussion section for further details).  448 
-5.3.2. Collect video and save in AVI format. 449 

- Phantom clean up 450 
5.4.  451 

- If bead-sticking is observed after an experiment, sonicate the phantom in an aqueous 452 
Alconox detergent solution using powers up to 70 W.  453 

  454 
-5.4.1. (Optional) Use of a pipe cleaner with matching diameter can also to facilitate 455 

cleaning. Note: This must be done carefully, although care must be taken  take care 456 
to ensure the phantom is not damaged. 457 

5.6. IMAGE PROCESSING AND DATA ANALYSIS 458 
- Image pre-filteringprocessingprocessing 459 
6.1.  460 

o Drag the saved AVI file onto the IimageJ window to Iimport it. AVI file into ImageJ in 461 
grayscale format. 462 

6.1.1. Select the box marked “Cconvert to Ggrayscale”. 463 
- From the “ImageJ” mMenu, Sselect “Analyze” > “Generate Histogram” (or press cCtrl 464 

+ H) to  Intensity capping 465 
o To increase the quality of the signal correlation, the difference between the peaks and 466 
valleys (i.e. contrast) of the input signals should be maximized11 . 467 

o Ggenerate a histogram of image pixel intensities. At high frame rates, the distribution 468 
is usually skewed heavily toward zero (i.e., no signal). Take note of the mean and 469 
standard deviation for the unprocessed image. 470 

6.1.2.  471 
  472 

 NOTE: At high frame rates, it is not unusual for the distribution to be 473 
skewed heavily toward zero (i.e., no signal). 474 

  475 
6.1.3. From the “ImageJ” ImageJ mMenu, Sselect “Image” > “Adjust”> “Brightness and 476 

Contrast” (or press Shift + Ctrl + H) to Aapply a brightness/contrast filter.  477 
6.1.4. On the “Bbrightness and Ccontrast” menu, Ppress the “Set” button to define the 478 

image limits. ChooseSet the minimum value to be  such that the intensity limits are 479 
set by the mean value plus one standard deviation from the statistics obtained in step 480 
5.1.2, and set the maximum value to be the maximum intensity of the image (both 481 
based on statistics obtained in Section 5.16.1.2).  482 
  483 
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o NOTE: obtained in step 5.1.2. This typically eliminates all but the top 10% 484 
of pixel intensities.  485 

o The number of standard deviations may be varied depending on the 486 
desired distribution of pixel intensities.  487 
o A custom macro script for performing the intensity capping operation is 488 
provided in the Supplemental Material. 489 
  490 

  491 
- From the “ImageJ” ImageJ mMenu, Sselect “Process” > “Noise” > “Despeckle” .  492 
o Optimization of brightness and contrast often increases the number of saturated 493 

pixels, which can appear as local maxima, and thus result in spurious vectors during 494 
subsequent cross-correlation.  495 

o The Despeckle function in ImageJ can be used to reduce the number of saturated 496 
pixels. 497 

6.1.5.  498 
  499 

NOTE: This operation is necessitated by the increased potential for pixel saturation 500 
that arises during optimization of brightness and contrast, which can produce 501 
spurious vectors during subsequent cross-correlation. 502 

  503 
- From the “ImageJ” ImageJ mMenu, Sselect “Process” > “Filters” > “ Gaussian Blur” 504 

with a radius of 1.5 to reduce artifacts arising from the . Select the radius to be 1.5. 505 
This value is selected because  506 

o Ddespeckling can occassionally removal ofe illuminated pixels in a 3x3 neighborhood 507 
by the prior despeckling operation. 508 

6.1.6.  509 
o Click on the “Ppolygon” tool, and then click within the image to outline the The 510 

Gaussian Blur function in ImageJ can be used to correct this effect. 511 
6.1.7. rRegion of interest (ROI).  512 
- From the “ImageJ” ImageJ mMenu, select “Edit” > “Clear Outside”  definitionto 513 

remove  514 
o6.1.8. Ssensor noise in locations where no signal is expected (e.g., areas beyond vessel 515 

wall boundary), which can decrease overall SNR. 516 
o The ImageJ ROI Definition function, followed by the Clear Outside function, can 517 

be used to black out regions outside the ROI, thereby increasing SNR. 518 
6.2. Data analysisPIV Calculation 519 

  520 
 521 
NOTE: This portion of the protocol e section below employs a third-party PIV plug-in for 522 
ImageJ for conducting PIV analyses, . Ensure the plug-in has been installed before 523 
implementing any of the operations below.which relies upon Gaussian peak-fitting to 524 
enable estimation of displacement with sub-pixel accuracy. 525 
-  526 
 527 
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 528 
  529 

6.2.1. From the “ImageJ” ImageJ mMenu, Cross-correlationSselect “Plugins” > “Macros” 530 
> “Run…” and navigate to the saved macro “Supplemental Codde 2.ijjm” to perform a 531 
batched correlation oncross-correlate successive image pairs.  532 
 533 

NOTE: The code performs an algorithmmacro isproceeds as follows: 534 
1)  535 
  536 
-  537 
 Cross-correlation of the intensity field within consecutive images is first 538 
performed to determine the local displacement of advected tracer particles, i.e.  539 
(i.e. the first image pair isconsists of the first and second imagesimages #1 and #2, 540 
and the second image pair pair isconsists of the second and third images, etc #2 541 
and #3, etc.). ; 2)  542 
o a 543 
The ImageJ PIV script allows multi-pass evaluation of the PIV fields.  544 
 545 
Here, aA two-step multi-pass evaluation was adoptedis then performed with 546 
initial and final interrogation window sizes of 256 x 256 pixels and 128 x 128 pixels, 547 
respectively; and finally, 3) . After the correlation is performed for all image pairs, 548 
the macro performs a temporal average to further reduce the potential for 549 
introductionappearance of spurious vectors. 550 
o  551 
 552 
 553 
NOTE: The peak in the correlation signal is typically not a discrete maximum at a 554 
single location, and thus peak fitting is needed to estimate the displacement with 555 
sub-pixel accuracy. The ImageJ PIV plug-in employs Gaussian peak-fitting for this 556 
purpose.  557 
 558 

6.3. Normalized median test (NMT) 559 
6.3.1. From the “ImageJ” ImageJ mMenu, select “Plugins” > “Macros” > “Run…” and 560 

navigate to the saved macro “Supplemental Code 3.ijjm” to perform a batched vector 561 
validation usingvalidate the velocity fields via the normalized median test.  562 
 563 

 NOTE: The macro algorithm performsisproceeds as follows: 1) Perform 564 
NMT for vector validation. 565 

 Each vector is compared to its eight nearest neighbors and the median 566 
value is determined.  567 

 568 
 eEach vector is in eachin an instantaneous vector field is first compared to 569 
its eight nearest neighbors andto compute the median value is determined; 2) . 570 
 tThe array of residual errors is then then calculated as the difference 571 
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between each neighboring vector and the median vector magnitudecalculated 572 
median; .3) t 573 
 The difference between the vector under investigation and the median 574 
neighboring vector value is then normalized by the median of the residuals; 4) . 575 
5.1. Tthis is then compared to a threshold value (typically 0.2 pixels), which can be 576 
varied based on a priori knowledge of noise during image acquisition; and finally, 577 
5) . 578 
  579 
 aA temporal average of all A custom macro script for performing the NMT 580 
operation is provided in the Supplemental Material. 581 
 This  script performs the normalized median test on each validated 582 
instantaneous vector fields before averaging them, since is performed to produce 583 
a composite field, as this has been shown to increase the vector field quality24. 584 

o  585 
o A custom macro script for performing the cross-correlation operation is 586 

provided in the Supplemental Material. 587 
- Averaging 588 

o Temporal averaging provides a means for mitigating the potential for 589 
introduction of spurious vectors, due to mismatching of local maxima in the 590 
cross-correlation for a given frame-pair.  591 

o Obtain an average of each velocity component at each grid point.  592 
 593 

 594 
- Normalized median test (NMT) 595 

o Perform NMT for vector validation. 596 
 Each vector is compared to its eight nearest neighbors and the median 597 

value is determined.  598 
 The array of residual errors is then calculated as the difference 599 

between each neighboring vector and the median vector magnitude. 600 
 The difference between the vector under investigation and the median 601 

neighboring vector value is normalized by the median of the residuals. 602 
 This is compared to a threshold value (typically 0.2 pixels), which can 603 

be varied based on a priori knowledge of noise during image 604 
acquisition. 605 

o A custom macro script for performing the NMT operation is provided in the 606 
Supplemental Material. 607 

o This script performs the normalized median test on each instantaneous vector 608 
field before averaging them, since this has been shown to increase the vector 609 
field quality22. 610 

 611 
REPRESENTATIVE RESULTS:   612 
Figure 2 illustrates the PDMS tissue phantom fabrication process. The phantoms designed herein 613 
are intended for the study of flow in idealized wide-necked, saccular, intracranial aneurysms, as 614 
well as proximal branching perforator arteries. Important additional design features include: 1) a 615 

Formatted: Font: (Default) Calibri, Font color: Black

Formatted: Font: (Default) Calibri, Font color: Black

Formatted: Font: (Default) Calibri, Font color: Black

Formatted: Font: (Default) Calibri, Font color: Black

Formatted: Font: (Default) +Body (Calibri), Font color:
Auto

Formatted: Font: Bold

Formatted: Font: (Default) Calibri, Not Bold, Font
color: Black

Formatted: Font: (Default) +Body (Calibri), Font color:
Auto

Formatted: Left, Outline numbered + Level: 3 +
Numbering Style: 1, 2, 3, … + Start at: 1 + Alignment:
Left + Aligned at:  0.5" + Indent at:  0.75"

Formatted: Font: (Default) +Body (Calibri), Font color:
Auto

Formatted: Normal,  No bullets or numbering

Formatted: Font: (Default) +Body (Calibri), Font color:
Auto

Formatted: Normal,  No bullets or numbering



   

Page 14 of 21  revised November 2017 
 

common reservoir that all vessels drain into, to ensure unencumbered fluid egress from the 616 
phantom, otherwise droplet formation may occur at the smaller vessel outlets; 2) a bubble trap, 617 
to facilitate bubble removal; 3) an outer cavity wall, to ensure parallelism of the vessel with the 618 
horizontal plane, as well as precise definition of the final phantom slab height, length and width; 619 
and 4) use of a 21 gauge hypodermic needle shank (820 µm nominal outer diameter) for molding 620 
of the perforator artery, due to our printer’s inability to define such features with sufficient 621 
fidelity. Faithful reproduction of all design features is observed throughout. 622 
 623 
Representative results for PIV-based flow characterization performed using the current protocol 624 
are presented in Figures 3 and 4. These studies were performed using phantom inlet flow rates 625 
of 100 mL/min, data acquisition rates of 2000 fps, and temporal averaging over spans of 0.05 s. 626 
Figure 3 shows representative image frames within the perforator artery, before and after 627 
intensity capping as well as corresponding surface plots of the 8-bit pixel intensity values. Both 628 
demonstrate that intensity capping significantly increases peak definition above the noise floor 629 
(i.e., increases SNR), which is critical to ensuring accuracy when performing subsequent cross-630 
correlation. Figure 4 shows the effects of intensity capping and NMT operations on the velocity 631 
vector field. Marked improvement in field uniformity is observed, thus further underscoring the 632 
importance of maximizing SNR to minimize data dropout.  633 
 634 
FIGURE AND TABLE LEGENDS:  635 
 636 
 637 
Figure 1: Particle image velocimetry setup. Reliance upon an open-source image analysis and 638 
pre/post-processing framework reduces demand upon the instrumentation for measuring meso-639 
scale flows, thus eliminating the need for many of the costly components of typical PIV systems 640 
(e.g., pulsed laser, synchronizer, cylindrical optics, &/or proprietary software). 641 
  642 
Figure 2: PDMS-based tissue phantom fabrication process: a) CAD model of neurovascular 643 
phantom mold; b) Printed ABS mold, after removal of support material; c) Casting and curing of 644 
PDMS within the ABS mold; d) Partial dissolution of ABS mold material; and e) Completed PDMS 645 
phantom, with inset showing final dimensions of key critical features, as well as the region of 646 
interest (ROI) in the perforator artery where the PIV measurements were made. .  647 
 648 
Figure 3: Effect of intensity capping operation on image SNR. Representative image frame and 649 
corresponding pixel intensity surface plots within the perforator artery, before (a, b) and after 650 
applying the intensity capping operation (c, d). 651 
 652 
Figure 4: Effects of intensity capping and NMT operations on velocity vector fields: 653 
Representative instantaneous velocity vector field within the perforator artery derived from: (a) 654 
unprocessed image data; (b) intensity capped data; and (c) intensity capped data + NMT post-655 
processing.  656 
 657 
Figure 5: Effect of interrogation window sizing on correlation quality. Optimal window sizing 658 
occurs when the value of the zero-normalized correlation coefficient is maximized, and the 659 
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standard deviation is minimized. 660 
 661 
DISCUSSION:  662 
The protocol described herein outlines a simplifiede and relatively low-cost method for 663 
performing PIV studies to visualize neurovascular flows at physiologically-relevant dimensions 664 
and flow conditions in vitroin vitro. In doing so, it serves to complement protocols reported by 665 
others that have also focused on simplifying the quantification of ying vector fields, but within 666 
very different contexts that require consideration of far larger length-scales2523 or lower flow 667 
rates26, 27(e.g. atmospheric or microcirculatory flows), and thus, reliance upon simplification 668 
schemes that are incompatible with the current application.  669 
 670 
o The most important considerations for successful implementation of PIV lie in the 671 
minimization of flow field artifacts and maximization of image quality. Several steps in the tissue 672 
phantom fabrication process are critical to both of these criteria. For example, thorough 673 
degassing is crucial since air entrained within the PDMS during mixing can lead to bubble 674 
formation within the final phantom, which can adversely affect both feature fidelity and optical 675 
clarity. Additionally, minimization of surface roughness of the ABS mold is desired, since the 676 
PDMS casting process faithfully reproduces even the most minute imperfections (e.g., build lines, 677 
surface pores, scratches, etc.), thus resulting in surface roughness in the final phantom that can 678 
decrease optical clarity and increase potential for bead accumulation. While the protocol 679 
described herein has proven sufficient for the current applicationbeyond the scope of the current 680 
protocol, , there are numerous reports in the literature of means for reducing such roughness, 681 
should there be need (e.g., acetone vapor smoothing28, or optimization of layer thickness and 682 
part orientation with respect to build direction)29). 683 
 684 
 685 
 686 
 Parameter selection for video capture is also critical to ensure a high-fidelity vector field. 687 
Optimal SNR is typically achieved at the highest achievable frame rate that still allows sufficient 688 
bead exposure (maximum frame rate being limited by minimum exposure time). Gain can be 689 
used to amplify the signal, but this also increases sensor noise.  690 
 If the maximum velocity can be estimated from other flow parameters (e.g., inlet 691 
volumetric flow rate), then a lower bound on the required frame rate can be estimated using the 692 
following relation30: 693 

 694 

𝑓𝑠𝑎𝑚𝑝𝑙𝑖𝑛𝑔 >
𝑣𝑚𝑎𝑥∙𝑐𝑐𝑎𝑙𝑖𝑏𝑟𝑎𝑡𝑖𝑜𝑛

ℎ𝑖𝑛𝑡𝑒𝑟𝑟𝑜𝑔𝑎𝑡𝑖𝑜𝑛 𝑤𝑖𝑛𝑑𝑜𝑤
 (1) 695 

 696 
where fsampling is the camera acquisition rate (Hz), vmax is the maximum expected velocity (mm/s), 697 
ccalibration is the calibration constant (pixels/mm), and hinterrogation window is the size of the 698 
interrogation window (pixels).  699 
 If the sampling frame rate matches fsampling, maximum local velocities are not captured via 700 
cross-correlation of image pairs, since the distance traveled by tracer particles in between frames 701 
exactly matches the length scale of the interrogation windows. Therefore, the camera should be 702 
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set to acquire images at a higher frame rate.  703 
 704 
 However, For the current application, it was found that cross-correlation is optimized 705 
when tracer particles travel ≤ 20% of the interrogation window width per frame-pair (see 706 
Discussion section for further details).  707 
For example, wWhile Equation 1 prescribes a lower limit for the frame rate, better more optimal 708 
values can be determined using so-called correlation quality estimation techniques, such as the 709 
zero-normalized correlation coefficient11. In this technique, the averages of complementary 710 
signals from each frame-pair are first subtracted, and then normalized by the standard deviation 711 
of their intensities11. If a displacement of the original signal exists, such that all peaks and valleys 712 
match, the time-shifted value of this signal will be equal to one. Conversely, if there is no 713 
displacement that can align these signals, the value will be zero. This information is included in 714 
the ImageJ PIV output for each vector, and it can be plotted as its own field to see ifverify whether 715 
there are spatial effects contributing to poor correlation (e.g., uneven lighting). The correlation 716 
coefficient can also be averaged over a field as an overall estimate of its quality. Finally, this 717 
quantity may also be plotted against varying frame rates or interrogation window sizes to 718 
determine an optimum. Figure 5 illustrates the results from such an analysis using a Monte-Carlo 719 
synthesized particle field with displacements consistent with our experimentally-measured flows 720 
(a typical technique for characterizing correlation quality11). The results show that the 721 
interrogation window size and frame rate should be chosen such that a particle field is displaced 722 
by ≤ 20% of the interrogation window size per frame-pair to maximize the correlation coefficient, 723 
while minimizing its variability.  724 
 725 
 726 
 727 
Although the protocol described herein has proven sufficient for meeting the needs of the 728 
current application, Finally, it is important to acknowledge its limitations.  of the current protocol. 729 
For example, , while the use of a fluorescence microscope with continuous, volumetric 730 
illumination allows for simplification of the imaging setup (relative to pulsed lasers and light-731 
sheet illumination), this comes at the cost of additional background fluorescence, thus requiring 732 
the implementation of various image processing operations prior to cross-correlation (i.e., 733 
intensity capping , Dedespeckle, Gaussian Blur, and ROI operations described in Protocol Section 734 
5). Similarly, while the NMT provides a means for improving the velocity vector field after cross-735 
correlation, it is important to emphasize that this is just one of many vector validation techniques 736 
that could be used22, 30, each with their own unique advantages and disadvantages that may make 737 
their use more suitable for applications beyond those described here. while contrast 738 
enhancement via intensity capping offers ease of implementation, transformations of the entire 739 
distribution of pixel intensities may improve SNR further31. Similarly, although correlation-based 740 
tracking is well-established and provides sufficient resolution for reliably estimating first-order 741 
flow characteristics relevant to hemodynamics (e.g., intra-aneurysmal velocity), other techniques 742 
may offer higher spatial resolution (e.g., hybrid PIV/PTV, least squares matching)32, 33, and thus 743 
greater accuracy when considering characteristics that are more sensitive to velocity field 744 
resolution (e.g., wall shear stress, in-plane vorticity). Likewise, while the NMT provides a means 745 
for improving the velocity vector field after cross-correlation, it is important to emphasize that 746 
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this is just one of many vector validation techniques that could be used24, 34, each with their own 747 
unique advantages and disadvantages that may make their use more suitable for applications 748 
beyond those described here.  749 
 750 
SimilarlyIn addition, the outlined approaches for image pre-processingfiltering, PIV calculation, 751 
and vector validation methods have all been chosen for their relative ease of implementation,; 752 
but each of these techniques are only one of several options and may be suboptimal in terms of 753 
accuracy when compared against more sophisticated methods. For instance, while image pre-754 
filteringprocessing in this protocol employs a simple statistical threshold  for contrast 755 
enhancement, transformations of the entire distribution of pixel intensities may improve the 756 
SNR30. Additionally, although the flow quantification technique outlined (i.e. correlation-based 757 
tracking) is well-established and enables sufficient resolution to estimate first-order flow 758 
characteristics relevant to hemodynamics (e.g. intra-aneurysmal velocity), other analysis 759 
techniques exist which can potentially achieve higher spatial resolution (e.g. hybrid PIV/PTV, least 760 
squares matching)31, 32. While out of scope of the current protocol, Tthese techniques may be 761 
more relevant for researchers interested in confirming the accuracy of estimates which are 762 
functions of higher-order spatial derivatives and are therefore more sensitive to velocity field 763 
resolution (e.g. wall shear stress, in-plane vorticity). 764 
  765 
SimilarlyLiekewise, while the NMT provides a means for improving the velocity vector field after 766 
cross-correlation, it is important to emphasize that this is just one of many vector validation 767 
techniques that could be used23, 33, each with their own unique advantages and disadvantages 768 
that may make their use more suitable for applications beyond those described here. 769 
 770 
Lastly, while our experimental setup seeks to mimic physiologically-relevant flow rates and length 771 
scales for the neurovasculature, it does not currently provide opportunity forallow the analysis 772 
of imposing pulsatile flows. This has not been a limitation for our current application, since 773 
However, since tthe range of Womersely numbers in much of the neurovasculature tends to be  774 
tend to be( ≤ 1 ( (i.e., there is minimal additive effect of multiple cardiac cycles)35, which this 775 
suggestssuggests that the steady-state conditions used herein are sufficient to resemble 776 
recapitulate oscillatory behavior during specificdiscrete time points along the cardiac waveform 777 
in which the flow rate is comparable. MoreoverHowever, for applications with where the larger 778 
Womersely number is largers (e.g., vasculature closer to the heart), we envision potential for 779 
introducing pulsatility through the use of an we anticipate potential for easily integrating 780 
pulsatile flow can be easily readily implementedity within the existing setup. For example, others 781 
have shown that an Arduino, which could be used to  may be used to send the motor pump a 782 
time-varying PWM , pulsewidth modulated (PWM) voltage waveform that enables mimicking of 783 
the a pulsatile cardiac flow profile seen in-vivo36–38.  784 
 785 
Conclusions: 786 
Within this protocol, we have demonstrated simplified methods for fabricating meso-scale 787 
neurovascular phantoms and characterizing the flow fields therein via PIV. For researchers 788 
interested in vascular flow, variants of this protocol may be particularly useful for early 789 
exploratory studies, where the cost of standard PIV systemsinstrumentation would be otherwise 790 
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prohibitive.  791 
 792 
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